
 
 
 

Color iMatch Industrial Help 
 

PDF files of the Online Help System for  
Color iMatch Industrial 

 
 
 
 
 
 
 
 
 

Document Version 1.0 
 

Document Date:  August 2005 
 

1



Getting Started 
 

Edit Default System Settings 
 
 The Change System Settings dialog (see image below) allows you to 
choose several default behaviors and the location of the default database and 
working job folders for Color iControl.  Color iControl can only keep up with one 
of each of these path settings at a time.  

 
If you create a new database using the "Create an empty Data Base" 

command under the Data menu, you must close out all current jobs and use this 
option to point to the newly created database.  Otherwise, the program will have 
no way to access the database you created.  However, you should keep track of 
where all your databases are stored.  Color iControl will not be able to remember 
where you have placed your data once you have changed the settings in this 
dialog. 
 
Below are field descriptions for the various options in this dialog. 
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Default System Settings Dialog Field Descriptions 
 
Current Desktop --- This field allows you to select from among the available 
desktops. You may also create a new desktop by clicking on the button to the 
right. The desktop feature is not required for system operation but is only 
included as a customizing option. See Desktop Management for more info. 
 
Default Settings File --- This field will display the settings file associated with the 
currently selected desktop. You may browse for other settings files using the 
magnifying glass button to the right. The desktop feature is not required for 
system operation but is only included as a customizing option. See Desktop 
Management for more info.  
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Default Toolbar File --- This field will display the toolbar file associated with the 
currently selected desktop. You may browse for another toolbar file by using the 
magnifying button to the right. The desktop feature is not required for system 
operation but is only included as a customizing option. See Desktop 
Management for more info. 
 
Databases --- This field allows you to select the default database path.  You 
should enter the full path name including the drive letter and any folders in the 
tree structure above the location of your database.  (You may have more than 
one database.  
 
Default Database Name --- This field allows you to select the default database 
you wish to use by name. Enter the full name including the .mdb extension. 
 
Jobs --- This field allows you to set the default path leading to the directory 
where you wish to store all the jobs created in Color iControl.  Include the drive 
letter and any folders in the tree structure above the location where you wish to 
store jobs. 
 
Local System Settings --- This field displays the path location where the files 
created by Color iControl containing the various settings options, including 
sensor settings and passwords are stored. This settings cannot be changed. 
 
Macros, Settings, Templates --- This field displays the path to the default 
location for storing macro file, settings files, and job templates. 
 
Texture Images --- This field displays the path to the default location for storing 
texture images used for rendering samples with unusual surface features. 
 
New jobs default to … --- When selected, this checkbox instructs the system to 
store settings in each job rather than in a settings file. 
 
Illuminant File --- These two radio buttons allow you to choose between different 
Illuminant tables, Table 5 for sensors with bandpass correction and Table 6 for 
sensors without bandpass correction. See the documentation provided with your 
instrument to determine the capabilities of your instrument. 
 

General Settings 
 
 The dialog box below shows the General Settings dialog options.  
Selected settings (for any mode) are stored in the settings file associated with 
that job. Field descriptions are included below. 
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Selected Color System --- These radio buttons allow the selection of the color 
system to be used within the various modes of Color iControl when making 
calculations. 
 
Database Name --- Allows the user to select the database to be associated with 
this job. This setting will override the default database setting for the system for 
this job. However, the database you select should still be located at the same 
path location as specified in the Default System Settings. You may also connect 
to a different database temporarily by clicking on the "Connect Temporary 
Database" button. 
 
Illuminants --- These three selection fields allow the selection of the primary, 
secondary, and tertiary illuminants for use in all modes while running Color 
iControl. Illuminants are named according to type (daylight, cool white 
fluorescent, incandescent, etc.) and the observer function (two or ten degree). 
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Concentration Units --- This selection box allows you to choose the 
concentration units that will be used in Formulation and Correction modes. The 
units selected here should match the units used in the preparation of your 
primaries before any measurements are taken. For some units, a small checkbox 
marked "Imperial" may appear which you can check should that option be 
needed. 
 
Number of Reads to Average (override cal mode) --- This field may be used to 
override the number of reads taken and averaged to create a measurement as 
set in the calibration mode. Setting this value will alter it for the current job. You 
may also use it when creating settings files or templates to create new jobs with 
a different value than that defined in the sensor's calibration mode. 
 
Printing --- This set of fields allows you to enter the name of your company (or 
whatever name you desire) which will appear as the header on all printouts 
generated by Color iControl. A print sub-header field is also included immediately 
below this one. 
In addition, a company logo may be included at the top of the printout if a bitmap 
image can be provided. This bitmap should be located in the System sub-folder 
of the Color iControl main folder. 
The positioning of the bitmap at the top of the printout can be controlled using the 
two fields beneath the bitmap selection drop-down. The first, Logo Start, requires 
a value between 0 and 100 for the location of the left edge of the bitmap, 0 being 
the left margin and 100 being the right margin. The second, Logo Width, requires 
a value between 0 and 100 as well, representing the size of the image in percent. 
Care should be taken when using the logo option since careless placement of the 
image could overwrite any headings included at the top of the printout. 
 
Default Measurement mode --- This field allows you to select a default mode for 
the spectrophotometer when taking measurements. 
 
Settings Filename --- This field displays the settings file (including full path) that 
is associated with the current job.  
 
Disconnect this job from settings file --- This button allows you to disconnect 
the current job from its settings file and store the job settings in the job. 
 
 

QC Settings 
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 This tab in the dialog box allows you to specify settings governing the 
quality control functions of the program.  The settings illustrated below are 
sufficient for most applications.  Letting Color iControl calculate tolerances using 
the DEcmc equation is generally the most efficient method.  

These settings will govern pass/fail tolerances for the program globally. If 
you need to set tolerances for an individual standard, you must do that through 
the Stored Tolerances tab of the standard's Properties... dialog. 

 
In addition, you must be sure to set the program to get the tolerances from 

the standard; otherwise, even if tolerances are stored with the standard, the 
system will use the program default. This is done in the "Get Tolerance From" 
section of the Quality Control tab of the Settings dialog. 

See below for field descriptions. 
 

 
 
Pass/Fail --- This section of the dialog allows you to specify the color difference 
equation which will be used by Color iControl to calculate color difference 

7



between a sample and the target  The selections available will depend on the 
color space you have chosen in General Settings. 
 When CIELAB is the chosen color space, there are six choices for the 
equation: DEcmc, DE*, DE*94, Rectangular (DL*, DC*, DH*), Rectangular (DL*, 
Da*, Db*), and Rectangular (DL*94, DC*94, DH*94).  DE*cmc is the standard 
CIE equation which uses weighted terms to calculate color differences.  DE* 
calculates the distance in CIELAB units from the standard without using the 
weighted factors employed by the CMC equation.  DE*94 is a newly-developed 
experimental equation which has been included for those interested in aiding in 
its evaluation.  You may use this new equation at your own discretion.  The last 
three options allow you to select to use a rectangular shape rather than an 
ellipsoid as your pass/fail option.  One rectangular selection is available for each 
of the three equations previously listed. 
 When you have either Hunter Lab or FMC-II as your chosen color space, 
there will only be two options in this drop-down menu.  For Hunter Lab, the 
choices will be DE and Rectangular DL,Da,Db.  For FMC-II, the choices will be 
DEf and Rectangular DLf, DRGf, DYBf. 
 
Pass/Fail Field --- This field allows you to enter a pass/fail limit for comparing 
samples to the target.  Samples which are farther than this value away from the 
target will fail; samples which fall closer to the target than this value will be 
considered passing. 
 
Pass/Fail Margin --- This field allows you to enter a value which will mark 
samples as only marginal rather than passing or failing.  For example, if you set 
your pass/fail limit to 1.00 DEcmc, you may set your margin value to 0.2.  This 
means that samples falling between 0.8 and 1.0 will be marked with a question 
mark rather than as an outright passing sample.  This marginal value only 
governs samples falling below the pass/fail limit. 
 
Test Under All Three Illuminants --- Checking this button will cause the system 
to automatically test the trial against the standard under all three selected 
illuminants. 
 
Also Test --- These check boxes also allow you to test individual delta values for 
the main CIELab or CIELCh color spaces. 
 
Get Tolerance From --- These three radio buttons allow you to select the 
location from which Color iControl will retrieve the tolerances that are to be used 
when comparing samples to the standard.  There are three choices: 
 From standard - Selecting this option means that you wish Color iControl 
to retrieve the tolerances which were stored with the standard at the time it was 
measured.  If no tolerances were stored with the standard, then Color iControl 
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will use the values stored as the system default.  To check and see if tolerances 
are stored with the standard, right click once on the standard in question in the 
Job Tree and select "Properties."  A dialog box will appear allowing you to 
examine any tolerances stored with that standard. 
 System Default - Selecting this option means that you wish to use the 
system default settings as your tolerances for comparing standards and samples.  
See Advanced QC Settings for more information. 
 Calculated - Selecting this option means that you wish Color iControl to 
calculate tolerances for each standard at the time you are comparing them to 
your samples.  The calculate option is only available when the CIELAB color 
space option is chosen in General Settings and DEcmc is the chosen equation.  
Tolerances cannot be calculated for either the Hunter Lab or FMC-II color spaces 
and must be either stored with the standard or retrieved from the System Default. 
 
 Important Note: The tolerance source is a cascade setting - if "From 
Standard" is specified but no tolerance is stored in the current standard, the 
software will fall back to the next level (From System), and if no system 
tolerances are stored then the software will use the "Calculated" option. 
 
Block Range --- The Block Range determines the number of sort blocks by 
which the ellipsoid of acceptability will be divided when using the 555 Shade 
Sorting method.  The options are 1, 3, 5, 7, and 9.  For more information on 555 
Shade Sorting, see Shade Sorting in Color iControl. 
 
L:C Ratio --- The L:C ratio governs the lightness to chroma ratio of the ellipsoid 
of acceptability when using the DEcmc equation for calculating color difference.  
This value is set to 2:1 for most textile applications. 
 
Strength Method - QC Settings --- This option allows you to select the method 
Color iControl will use to calculate strength for the strength-adjusted calculations 
available as attributes for display in the Standard/Multi-Trial View.  The options 
are Single Wavelength, Summed, and Weighted Sum.  Single Wavelength is the 
preferred method for calculating strength based on transmittance data.  Weighted 
Sum is the preferred method when calculating strength based on reflectance 
data. 
 
Density Method --- This drop-down box allows you to select the method used to 
calculate density. Values for this drop-down list are located in the "density.table" 
located in the system subfolder of the main Color iControl folder. 
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Settings Options 
 This tab of the Settings dialog allows you to select from a variety of 
program options. Clicking on the checkbox enables the item. 

 
Auto-accept standards --- Selecting this option prevents Color iControl from 
double-checking with the user before storing newly read measurements from the 
instrument.  Normally, after measuring a standard the program will display the 
measurement data, along with fields for naming the standard, concentration, etc., 
and then ask you if you wish to store the data.  This option eliminates the double-
check and immediately stores the standards and moves on to the next 
measurement.  Also, if this option is turned on, the user will not be given the 
opportunity to enter tolerances for that standard manually. 
 
Auto save measurements to database --- Normally, in order to save 
measurements to the database, you must select "Save to Database..." from 
under the Data menu.  However, selecting this option instructs the program to 
automatically save all measurements to the database for recall later. 
 
Auto promote standards on trial reading --- Checking this box instructs the 
program to automatically select among multiple standards which standard is to 
be promoted to current status in the job based on the Pass/Fail tolerances in that 
job. This will be done as each trial is read so long as the standard being 
promoted is 1.5 (default) Pass/Fail tolerances from the standard. If a trial is read 
that is not within the pass/fail limits, the currently selected standard will be 
demoted so that the main standard slot is empty. 
 
Auto save/refresh colorants to database --- This checkbox affects program 
operations whenever you are in Primary Evaluation. If checked, whenever you 
evaluate a set of primaries and store them as a colorant into the current job, that 
colorant will also be stored to the database at the same time. This does not mean 
you will store those primaries to the database, only the colorant will be auto-
stored. Note: Primaries can only be evaluated and colorants stored in the iMatch 
version of Color iControl. 
 Checking this option also instructs Color iControl to re-load all of the 
colorants in the current job from the database immediately upon opening the job. 
This ensures that all colorant information in the job is current. For example, some 
colorants may have had their cost values increased. By auto-refreshing the 
colorants, an older job would automatically have the correct cost value.  
 
Auto save jobs every --- This field allows you to set Color iControl to auto-save 
jobs in case of a system crash or other malfunction. You may use the field 
provided to enter an interval (in minutes) for the auto-save to be performed. This 
field defaults to sixty (60) minutes. 
 
Auto Average Trials --- Checking this option enables the system for auto-
averaging during the trial measurement process. With this option enabled, the 
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"Read Trials" dialog box will contain a small button that reads <End Avg>. 
Clicking on this button will automatically average all of the trials read up to that 
point; a dialog box will appear that allows you to name the average. Once you 
have named the average, the system will place it into the current job at the 
bottom of the trial list in the Tree View. 
 The "Read Trials" dialog also contains a button allowing you to enable this 
feature without opening the settings dialog. When reading trials, simply click on 
the "Begin Avg" button before you read the first trial you wish to include in the 
average value. Once all the trials you wish to average have been read, click on 
the <End Avg> button. Name the average and click on OK. 
 
Auto Clear Views on Read Dialog --- Checking this option instructs the program 
to clear all of the samples from all of the current views when the user opens a 
Read dialog in order to make measurements. 
 
Auto Show Only Associated Trials --- This checkbox instructs the system to 
automatically display only those trials in a job that are associated with the current 
standard.  
 
Close Read Dialog after measurement --- This checkbox instructs the program 
to close the read dialog after each measurement. 
 
Use name formatting --- Selecting this option enables the formatted Naming 
Conventions.  See that section for more information. 
 
Default To Transmittance mode --- This checkbox changes the default for your 
sensor to measuring in transmittance mode rather than reflectance. 
 
Ask for Comment on measure --- Checking this box enables the system to 
allow the user to enter a comment with each measurement. A comment field will 
appear in the Read dialog box immediately after you enter a name for the 
measurement, replacing the name field. You may enter a comment up to a 
maximum of sixty characters.  
 
Ask for Length of Trial on measure --- This setting causes the program to 
include a field in the Read dialog which allows the user to enter the length of the 
piece being measured. 
 

Advanced QC Settings 
 
 Although this section is referred to as Advanced QC Settings, all the items 
discussed here are set from the same tab as in the regular QC Settings. This 
section is referred to as "advanced" due to the complexity of some of the other 
settings.  
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The image below shows the QC tab when the Rectangular (DL*, DC*, 
DH*) option is selected in the Pass/Fail box.  Rectangular tolerancing allows you 
to include those samples which would normally fall outside the ellipsoid of 
acceptability calculated using DEcmc (i.e., those samples falling into the corners 
cut off by the ellipsoid). 
 
 In this figure, notice that the Block Range is set to one and the Tolerance 
Location is set to "System Default."  When a Tolerance Location other than 
Calculated is selected (either "From standard" or "System Default"), a set of 
fields will appear at the bottom of the dialog allowing you to enter the desired 
tolerances.  (Values set in the System Default fields will be used whenever Color 
iControl cannot locate tolerances stored with the standard, even when "From 
standard" is the selected tolerance source.)  
 

The  Margin field will not be available when rectangular tolerances are 
selected and the Block Range is set to one. 
 

 
 
  Furthermore, if the Block Range is set to one, you may select tolerances 
which offset the location of the standard within the rectangular shape designated 
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as equivalent to the standard in shade.  This is accomplished by allowing you to 
enter both lower and upper tolerances for each of the five values included for 
these settings (DL*, Da*, Db*, DC*, DH* -- These selections are only available 
when CIELAB is the selected color space.  The selections for Hunter Lab and 
FMC-II are DL, Da, Db and DLf, DRGf, and DYBf, respectively.)  You may only 
enter upper and lower tolerances when the Block Range is set to one.  
 

A higher setting for Block Range will cause the System Default Tolerances 
area to only display entered tolerances as plus/minus, that is, the dimensions of 
the rectangle will be symmetrical with respect to the standard.  This option is 
illustrated below.  Notice also that the Pass/Fail and the Margin fields are once 
again available. 
 

 
 

How to Set Pass/Fail Tolerances 
 
 Color iControl has been designed to allow color evaluation in a variety of 
industrial settings. Because of this, some of the controls governing color 
tolerancing can be quite complicated. Once aspect that can be very confusing is 
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the textile industry's practice of shade sorting, i.e., not only determing whether a 
piece is on-shade or not, but also sorting the samples so that each one can be 
grouped with others very close in color, yet all still on-shade to the standard. This 
process is completely uneccessary for many of the other applications of Quality 
Control. 
 For those users who do not need any form of shade sorting, the main 
setting that needs attention is the "Block Range" option found in the QC Settings 
dialog box. For textile users, this box determines how the 555 shade sorting 
method will be applied by the software. See Advanced QC Settings for more 
options. 
 For non-textile users, this feature should be set to a value of one (1). 
Setting the Block Range to one basically turns off the shade sorting features. 
 Once the Block Range is set to one, the other settings governing a basic 
pass/fail system of tolerancing can be put into place. Selecting whether you wish 
to use CIELab's DEcmc equation, simple DE, or rectangular coordinates can be 
done using the available drop-down list. Once the equation is selected, enter the 
pass/fail value as well as a pass/fail margin in the fields provided. The margin 
value is used to determine questionable passing samples that are still within 
tolerances but outside the margin value. For example, if you set your tolerances 
to one DEcmc and your margin to 0.10, then a sample falling 0.95 DEcmc away 
from your sample would be marked as questionable. 
 
Important Note: To see Pass/Fail icons or the Pass/Fail column in the 
Standard/Multi-Trial view, the “Pass/Fail”Margin” attribute must be selected for 
display in the view’s Properties… dialog. 
 
 
Setting Tolerances for Individual Standards --- DEcmc, Logical and 
Statistical Tolerancing 
 
 Tolerances set through the Quality Control Settings tab will be applied 
globally throughout the program. However, in many instances, users may need to 
set tolerances for individual standards with each standard having different 
tolerances. When this is the case, the tolerances will need to be set for that 
standard through the Stored Tolerances tab of the standard's Properties... dialog. 
(When using tolerances stored with the standard, remember to set the program 
to retrieve tolerances from the standard in the QC settings dialog.) 
 You may enter in the desired tolerances by hand or use the automatic 
options. The first automatic option allows you to set the program to use 
tolerances based on the CIELab DEcmc equation. Just click on the "Calculate 
from DEcmc" and the program will automatically calculate the tolerances. 
 The second automatic option is Statistical Tolerancing. This option 
requires that at least ten trials be selected in the job (this provides a sufficiently 
large data set). Enter a Sigma limit in the field provided and click on the Compute 
Statistical Tolerances button. 
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 The last automatic option is Logical Tolerancing. This method requires 
that at least ten failing trials be loaded into the job and selected. (Only failing 
trials should be selected.) Then, click on the Compute Logical Tolerances button. 
The system then calculates the smallest tolerances in each dimension that 
includes the acceptable samples. Once that is done, the system calculates the 
largest tolerances possible that still exclude the highlighted failing samples. The 
software then determines which samples fall on or between those two ranges. 
Those samples are then averaged in order to calculate the mean "best fit" 
tolerances between the two boundaries. The resulting tolerances are then loaded 
as the default for the standard. 
 See Additional Properties of Standards for more information. 
 

Shade Sorting in Color iControl 
 
 Shade sorting is a term used to describe the quality control practice of 
comparing samples to a standard and sorting them into groups having similar 
differences from the standard.  The alternative to shade sorting is a pass/fail 
method.  Shade sorting is a more complicated method than pass/fail.  Pass/fail 
simply checks a sample's distance in color space from the standard and 
compares that difference to an established pass/fail limit.  For example, DEcmc 
is an excellent tool for pass/fail.  If it is over the pass/fail tolerances set by the 
user, then the sample fails as a match to the standard.  However, this method 
does not really tell us anything about the sample's relationship to other samples 
or the quality of the difference between the standard and the sample, i.e., does 
the sample differ in hue, chroma, or lightness?  The 555 shade sorting method 
offers limited advantages over a simple pass/fail. 
 
555 Shade Sorting 
 
 555 shade sorting is a process often employed when a large number of 
samples need to be separated into groups based on shade similarity.  The 555 
sorting system consists of a three-dimensional arrangement of rectangularly 
shaped boxes, stacked nine deep in each of three dimensions (usually lightness, 
chroma, and hue) and centered around the standard.  
 

These nine sort block levels (or whatever that value is set to) will all fall 
within the established tolerances. That is, if you have sort blocks set to five, then 
only the five levels immediately around the standard will fall within the ellipsoid of 
acceptability.  

 
Color iControl will actually calculate as many sort blocks as necessary to 

place all the samples, resulting in the possibility of seeing sortcodes like 20, 30, 
or even 100, depending on how off-shade the given sample is. 
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 The center box, within which the standard falls, is designated the 555 box, 
and any other samples which fall into this box are judged to be equal to the 
standard and given the same sort code of 555.  
 

As samples fall further away from the standard in any direction, they will 
fall into other boxes and be accordingly classified.  Thus, you can instantly relate 
the fact that five rolls which are each coded 375 are darker and brighter that the 
standard, but sufficiently close to one another to be used in the same garment.   

 
This ability of sort code numbers to convey useful information about each 

sample's relationship not only to the standard but to other samples makes it a 
successful method for minimizing the problems associated with shade variation. 
 
 How close the samples all falling into one sort block are to each other 
depends on the size of that sort block.  In Color iControl, you have the choice to 
select from one to nine as the sort block range, with the most common choice 
being five (this is also the default range).  
 

A sort block setting of five means that there will be two levels of sort 
blocks (within the tolerances) calculated above the central block level containing 
the 555 block and two below, setting the range to seven means that there will be 
three levels of sort blocks above and below the one containing the 555 block.   

 
However, no matter how many or how few sort blocks you choose, they 

will be dividing up the same ellipsoid of acceptability.  Therefore, the greater the 
sort block range, the smaller each block will be and the closer each sample in 
that block will be in shade to each other. 
 
 So, we must understand what are the factors that determine the ellipsoid 
of acceptability. 
 
Factors Determining the Ellipsoid of Acceptability 
 
 There are three factors which determine the size of the ellipsoid of 
acceptability which Color iControl draws around the standard and which is 
divided up to form the 555 shade sorting blocks (when using DEcmc to 
calculate).  
 

These three factors are the L*a*b* values for the standard, the pass/fail 
volume, and the l:c ratio.  The L*a*b* values determine the standard's location in 
color space.  This is very important since color space is not uniform.  The ellipse 
for a yellow sample will be larger than the ellipse for a blue sample even if the 
three factors are set to the same values due to the differences in the yellow 
portion of color space as opposed to the blue.  

 

16



The pass fail volume determines the basic diameter of the ellipse, while 
the l:c ratio (standing for lightness to chroma) determines how long the ellipse will 
be compared to its width.  (This value is typically set to 2:1 for textile 
applications.)  

 
All of these values may be set in the QC tab of the Settings dialog. 

 
Using the 555 Shade Sorting Method in Color iControl 
 
 To use the 555 shade sorting in Color iControl, you must select to display 
the 555 sortcodes in the Standard/Multi-Trial view.  To do this, you must edit the 
Std/Multi-Trial View Properties and select Sortcodes- DLab, Sortcodes DL*a*b*, 
or Sortcodes-DL*C*H* as a display option.  The Sortcodes-DL*C*H* option 
displays sortcodes exactly the same as the DL*a*b* option except that the 
second sortcode represents the DC* of a sample rather than its da* value and 
the third sortcode represents the DH* value rather than the Db* value.  The 
sortcodes for each sample will then appear in the appropriate column.   
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Desktop Management  
 
 

Desktop Management 
 
 Color iControl allows the creation of desktop layouts that can affect many 
of the software's operating parameters, including such global settings as the 
default database folder or default jobs folder. In addition, a desktop can be 
associated with a user ID so that as soon as a user logs on to the system (even if 
passwords are disable), the correct desktop will instantly be applied to the 
program. 
 
 Desktops are selected and created from the System tab of the Settings 
dialog box. A drop-down list at the top allows you to select from previously stored 
desktops. All of the default system settings will be stored with the desktop. This 
means that any or all of the default data paths may be left alone or changed 
when creating new desktops. This allows different desktops for different users to 
point to different databases or to store their jobs in different folders. 
 
 In addition, this dialog allows you to select a default settings file (*.st3) to 
be associated with each desktop, as well as a default toolbar file (*.tlb). See 
Settings, Templates, and Layouts for more information on settings files. See 
below for information about editing the toolbars (toolbars in Color iControl are 
user-configurable). 
 
Editing the Toolbars 
 
 The toolbars may be configured to each user personal preference. To do 
so, click on the downward facing arrow located at the bottom of the darkened bar 
at the right-end of the toolbar.  A small popup box will appear with the words 
"Add or Remove Buttons." Placing the mouse cursor on this popup will cause 
another menu to appear displaying the current toolbars.  Placing the mouse 
cursor over one of these will display that toolbars default selections. You may 
check or uncheck each button option as needed (see image below). In addition, a 
"Reset" option is at the bottom to restore the toolbar to its default state. 
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. 
 In addition, the "Customize..." option at the bottom of the second menu 
allows you to add a toolbar for any command available from the main menus. 
Clicking on this option opens a dialog box (see image below). Each of the three 
tabs allow different levels of toolbar creation and/or display. 
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This tab allows you to select to create a new toolbar, reset an existing toolbar, 
rename a toolbar, or delete a toolbar. (You may not delete or change the basic 
four default toolbars except as noted above.) 
 

 
 

This tab allows you to add a button from any of the main menu selections to your 
personal toolbar. 
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This tab allows you to specify various behaviors and some aspects of the 
toolbar's appearance. 
 

Permissions Descriptions 
 
 Using the “Manage” command from the Account menu allows supervisors 
to create user accounts. You may specify the amount of access to program 
functions each user has by checking that option. Each of the available 
permissions are listed below with a brief explanation. 
 
Delete Data from Jobs - Selecting this option allows the account to delete data 

from jobs. This includes replacing a standard in a job with a standard 
already loaded. For example, you open a job with a standard already loaded 
into it and you do not have permission to delete data from jobs. You will not 
be able to read a new standard into that job since a job can only contain one 
standard and reading in a new one entails deleting the old one, an action 
which you do not have permission to perform. 

 
Delete Data from the Database - Selecting this option allows the account to 

delete data from the database. 
 
Set Up Name Formatting - Selecting this option gives the account access to the 

Formatted Name Setup dialog box (reached through the Configure Naming 
Conventions... command under the Data menu). 

 
Modify Data in Job - Deselecting this option disables several of the right-click 

menu options in the Job Tree View in QC mode preventing the user from 
altering the data in the job. The "Create Hitch," "Correct Measurement 
Using Hitch Factors," and "Properties..." options will be grayed out and 
unavailable unless this option is selected for use by the account. 

 
Save Data to Database - Selecting this option disables the "Save to Database" 

command for the account, both from the Job Tree right-click menu in QC 
mode and under the Data option in the main menu. 

 
Do Formulations - Selecting this option gives the account access to Formulation 

mode. 
 
Do Corrections - Selecting this option gives the account access to Correction 

mode. 
 
Evaluate and Store Primaries - Selecting this option gives the account access to 

the Primary Evaluation mode. 
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Change System Settings - Selecting this option gives the account access to the 
main settings dialog box in each mode, otherwise, that option will be grayed 
out. In addition, the "Properties..." option in the right-click menu of each 
view will also be unavailable without this permission. 

 
Setup or Modify Password Accounts - Selecting this option gives the account 

access to the Account Management dialog box opened through the 
"Manage" command under the Account menu. 

 
Run the Instrument - Selecting this option gives the account access to the 

instrument, including calibration and taking measurements. 
 
Change Database Path - Selecting this option gives the account access to the 

Default System Settings dialog box accessed through the Settings dialog 
menu. (Also available through the Edit Default System Settings command 
under the File menu. 

 

Toolbar Buttons 
 
 The toolbar at the top of the screen provides quick access to many 
functions in Color iControl via its buttons.  All functions incorporated into the 
toolbar may also be accessed through the drop-down menus.  There are also 
several buttons in the program specific to each mode.  These buttons do not 
appear in the general toolbar.  The icon image selected for each button is 
displayed below (in order from left to right), along with a brief explanation of the 
button's function.  
 
Basic Functions 
 

 Opens a new job. 
 

 Opens a new job based on an existing template. 
 

 Saves the current job. 
 

 Opens an already existing job. 
 

 Prints data from the current mode of the current job. 
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Settings Button 
 

 Opens a dialog box which allows the specification of settings associated 
with the current mode. 
 
 
Macro Selection Dialog 
 

 Opens a dialog box allowing the user to select a macro to run in Color 
iControl. 
 
 
Sensor Management Buttons 
 

 Opens a dialog box which allows the sensor to be calibrated. 
 

 Opens a dialog box which allows the specification of settings governing 
the calibration of the sensor. 
 
 
Data Management Buttons 
 

 Reads a sample from the sensor and automatically stores it as a standard 
(target) in the current job. 
 

 Opens a dialog box which allows you to recall a standard from the 
database. 
 

 Reads a sample from the sensor and automatically stores it as trial data in 
the current job. 
 

23



 Opens a dialog box which allows you to recall trial measurements from the 
database. 
 

 Opens a dialog box which allows you to save any form of data from the 
current job to the database. 
 
 
E-Submit and Extended Tagging Buttons 
 

  This button will only activate when a QTX or XML file is waiting in 
the appropriate mailbox or folder after having been received as a submit.  

 This button will activate when any trials are selected and allows you to use 
the eSubmit option to export the data as a QTX or XML file.  
 
 

Tree View Toolbar Buttons 
 
 The Tree View has its own toolbar which allows users to choose from a 
wide variety of display functions, review an item's properties, or to export items to 
a particular file format (EXP, QTX, etc.). Each of the toolbar's buttons are 
illustrated below with a brief explanation of its function. 
 

 This button expands the Tree View to display all the various levels of data, 
standard, trials, substrates, resins, colorants, etc. 
 

 This button displays all of the data in the Tree View (not including 
colorants) in the available data views. 
 

 This button displays only the selected data from the Tree View in the 
available data views. 
 

 This button removes all item from the data views. 
 

 This button sorts the data in the Tree View by date of measurement. 
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 This button eliminates any sorting done and returns the data in the Tree 
View to its original sort order. 
 

 This button copies a selected item to the data section of the Tree View. 
 

 This button copies a selected item to the standard position. (Remember, 
only one item can be in the Standard slot at a time.) 
 

 This button opens a dialog box allowing you to create a measurement. 
 

 This button will average a new trial measurement based on all of the trials 
currently selected when the button is clicked on. 
 

 This button will average a new standard based on the data currently 
selected when the button is clicked on. 
 

 This button opens the Properties dialog box for the selected item. 
 

 This button will show the selected items in the available data views. 
 

 This button will export the currently selected items to an EXP formatted 
file. 
 

 This button will export the currently selected items to a QTX formatted file. 
 

 This button will export the currently selected items to a NetPalette file. 
 

 This button will automatically start the formulation process and attempt to 
match the currently selected item. 
 

 This button will sort the data on colorimetric data. 
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 This button will sort the data by name. 
 

 This button will export the selected data to a CXF formatted file. 
 

Settings Files and Templates 
 
 It is important to understand the differences between these two program 
options and how they affect the operation of the system. Each is discussed 
below. 
 
 
The Settings File 
 

Users may choose how they want their settings saved, in the job or in a 
"settings file." The default method is to use the settings file option. However, the 
first time you run the software after installation you will be prompted to select the 
System Default Settings at which point a checkbox allows you to switch the 
system from using settings files back to storing that information in each job. 
 

Whichever method you select, you will still have the option to change the 
way in which an individual job stores its settings when running the software. 
 
 The settings file option has been designed to provide an easy way to 
ensure continuity for the settings established for any particular type of job (i.e. 
quality control, formulation, correction, etc.) Multiple jobs can all point to the 
same settings file, providing a single source for the values governing calculations 
in all those jobs. Multiple settings files may be created and jobs linked to them, 
providing an easy way to set up for a variety of tasks while still maintaining 
continuity for the settings established for those tasks. 
 One of the main advantages to using the settings file (as opposed to 
storing them in each job) is that it allows users to make global changes to large 
numbers of jobs by simply editing one settings file. 

For example, you have a large number of formulation jobs, each loaded 
with a particular standard. Previously, you had the system set up to sort the 
formulas on DEcmc, Predicted Performance, and Cost. However, you now need 
to sort formulas on Predicted Performance, Metamerism, and Cost. 

The settings file allows making this change easily. Simply open one of the 
formulation jobs and make the change in the Formula Display tab of the settings 
dialog, then click once on the "Save Settings" command under the Job menu. 
The new settings will be saved to the file. All formulation jobs pointing to that 
settings file will now sort their formulas on the Predicted Performance, 
Metamerism, and Cost. 

26



 One of the other advantages to using the new settings files is in the 
creation of templates. Previously, you could include settings (as well as data) in a 
template; new jobs created from that template would automatically include the 
settings from the template. However, editing the template to include new or 
different settings would only affect jobs created using that template after the 
changes were made. Jobs created from that template prior to the changes would 
still contain the old settings. 
 Templates (like jobs) may now be created to point to a particular settings 
file. Any jobs created from that template will also point to that settings file. If you 
need to make changes to that template, you may simply edit the settings file. Not 
only will all new jobs created using that template contain the changes, but all of 
the old jobs associated with (pointing to) that settings file will also be changed at 
the same time. 
 However, not all users require that kind of continuity. In fact, there are 
many users who need different settings for their jobs on a regular basis. For 
those users, the option to store their settings in the job is the best way to set up 
the system. This is because if every job needs different settings, then every job 
would have to have its own settings file. This would be a waste of system storage 
space as well as a waste of time for the user who would have to create a unique 
settings file for each job. 
 Another reason to store settings in the job is that it makes sharing data 
between users easier. Sending a job via e-mail to another user is a lot easier 
when that job is self-contained. When a job is linked to a settings file, both the job 
and the settings file would have to be sent since the job cannot be opened 
without its settings. 
 
 
Templates 
 
 Templates in Color iControl are much the same as the templates you can 
create in a word processing or spreadsheet application. For example, many word 
processing packages allow you to create templates for documents you need on a 
regular basis, such as business letters, price quotations, packing slips, etc. In 
Color iControl, creating templates can be a good way to set up jobs ahead of 
time for frequently performed tasks. 

For example, you know that you frequently have to formulate using the 
same substrate and the same set of colorants but a different standard. Setting up 
a template ahead of time by loading the substrate and colorant data into it makes 
creating those formulation jobs a breeze. You would simply select the "New Job 
from Template" option from under the Job menu, select your template, and click 
<Open>.  Read the standard with the sensor or recall it from the database and 
you are ready to formulate. 
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Data Management  
 
 

Recalling Data from the Database 
  
 Any data previously stored to the database may be recalled for use in the 
current job.  The five data types each have their own command, listed in order 
under the Data menu: Recall Standard, Recall Trial, Recall Substrate, Recall 
Primaries, and Recall Colorants.  Clicking on any of these commands will bring 
up a dialog box allowing you to specify the data you wish to use (see illustration 
below). 
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 If you are recalling a colorant, the above dialog will appear slightly 
differently.  The main difference will be that the choices under Spectral Type will 
be limited to two, Reflectance and Transmittance, and you will not be able to 
select a data type since only colorants may be recalled from the Recall Colorants 
from Database dialog. 
 
 The main "Recall from Database" dialog box has been designed to allow 
you to specify a particular attribute of the data you wish to retrieve and search 
the database for all items containing that attribute.  The attribute may consist of 
the item's name, any of the parts of a formatted name, or any user groups 
associated with that item. 
 

If you choose not to specify any limiting attributes, clicking OK will bring up 
a second dialog box (see below) allowing you to select from the entire database.  
This means that all of the standards (or whatever data type was specified) in the 
database will be retrieved for viewing in the selection dialog.  This is not 
recommended for a large database since retrieving the data will be time-
consuming. 
 
Specifying Search Attributes for Data Recall 
 
 There are seven different attributes you may specify to limit your recall 
from the database.  These are: Full name, Formatted name, Data Type, Spectral 
Type, User Group Designations, Color Search, and Measurements Containing 
Formulas. 
 
 Data Type may be specified by the option you select from the Data menu, 
i.e., Recall Standard, Recall Trial, etc . In case you wish to recall one type of data 
into another data type position, a drop-down menu is also provided in the Recall 
from Database dialog box to allow you to select the data type.  For example, you 
may choose Recall Standard and change the data type to Trial using the pull-
down menu.  The trial recalled in this manner will be displayed as a standard. 
 
 The remaining attributes may be entered into the Recall from Database 
dialog box.  Two of those attributes, Full name and Formatted name, are 
mutually exclusive; that is, you will never really want to use both these fields at 
the same time.  If you are not using the name formatting option, you should just 
use the Full name field.  Type in the name of the sample(s) you wish to retrieve.  
A partial name may be entered as long as you use an asterisk at the end.  The 
asterisk tells Color iControl that you are searching on a partial name.  For 
example, you wish to find all samples beginning with the letters "lan".  You would 
enter into the name field, "lan*".  Color iControl would retrieve all samples with 
"lan" as the first three letters. 
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 However, if you are using the name formatting option, you should ignore 
the main Full name field altogether and use the Formatted area of the dialog.  
Using this section allows you to search on any individual string which may be 
contained in the name.  For example, you set up a formatted naming system to 
have four fields: dye lot, color, fabric, style.  However, if you wanted all samples 
that were a particular color, but were not concerned with their dye lot, fabric, or 
style, you could enter that color in the color field and only samples containing that 
color in the second string would be retrieved.  Or you could combine the color 
with a dye lot number or a fabric and only retrieve items that were that color from 
that particular dye lot or dyed on that fabric. 
 
 It is possible to type in the entire formatted name into the Full name field 
and retrieve the data.  However, you would have to type in the correct fill and 
separator characters in order for Color iControl to be able to find the item in 
question.  When using the formatted names, it is best to ignore the Full name 
field and only use the Formatted name area of the dialog. 
 
 The fourth search specification is the spectral type of the data.  Use the 
radio buttons in the dialog to select the spectral type for the data you wish to 
retrieve.  The choices are: Reflectance, Total Transmittance, and Diffuse 
Transmittance.  When recalling colorants, your choices will be limited to 
Reflectance and Transmittance. 
 
 The fifth search specification you have at your disposal is the User Group 
Designation.  If you know the user groups designations for the samples you are 
seeking, enter them into the fields provided.  You may specify only one or all of 
the user groups your samples have been placed into. 

 
 For example, you have decided to identify all of your acid-based colorants 

by labeling them as "acid" in the User Group 1 field.  Furthermore, you have 
broken them down further by labeling them according to whether they are high, 
medium, or low energy dyes.  This information is contained in the User Group 2 
field.  

 
If you place the "acid" label into the Group 1 field, when you click OK, 

Color iControl will bring up all the colorants that have been identified as acid-
based.  However, you could furthermore limit the search by entering the "high 
energy" label into the User Group 2 field.  This would only bring up the colorants 
that are high energy and acid-based. 
 
 Alternatively, you could skip the first user group field and only enter the 
"high energy" label into the second user group field.  This would result in Color 
iControl bringing up all colorants that are high-energy.  However, since you did 
not limit the search in the first user group field, you would see all colorants that 
are high-energy and not just the ones that are acid-based. 
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 Along with User Groups, you may use up to four e-Submit fields as 
additional search criteria provided you have enabled that option. Immediately 
below the User Group fields are two sets of drop-down lists. The set on the left 
allows you to select from the e-Submit labels as defined in the current format file. 
The set on the right allows you to select from the content options for each 
selected label. 
 
 Sixth, you may perform a color search.  Type L*a*b* values into the 
appropriate boxes.  Alternatively, you may choose any sample in the Job Tree 
and then choose the Recall command to have the L*a*b* values for that sample 
automatically entered into the boxes.  Click the radio button for either DEcmc or 
DE* and enter the desired DE value.  When OK is pressed, the database will be 
searched for samples with L*a*b* values within the specified DE of the L*a*b* 
values entered here. 
 
 The seventh and last option is located at the bottom of the dialog and 
allows you to instruct the program to only retrieve colormetric matches containing 
formulas meeting specific conditions. There are three fields allowing you to 
specify attributes of a formula: Fiber, DyeClass, and Process. Fiber allows you to 
select a substrate for the formula you wish to retrieve. DyeClass allows you to 
select the type of dye the formula contains, i.e., acid, disperse, vat, etc.  Process 
allows you to specify the process used for the actual dyeing, i.e., exhaust, 
continuous, pad, or other. Of course, this option only works if the formulas stored 
with the standard or trial had its attributes set at the time it was stored to the 
database. 
 
 

Selecting the Data from the Possible Matches 
 
 Once any search specifications are entered into the Recall from Database 
dialog and you have clicked OK, a second dialog listing the possible matches to 
your search will appear (see image below). 

A fourth column is included in this dialog which displays each data item's 
unique ID assigned to that item when it was originally read into the job. Use the 
scroll bar to view this column when examining data whose names are identical 
(generally primary data will all have the same name). The unique ID (consisting 
of several letters and numbers combined) is displayed in Name tab of the data 
items Properties… dialog. 
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 Once the possible matches to your search have been located, you may 
select the data you wish to recall into the current job.  You may use the Select All 
button at the bottom of the dialog.  If you do not need all of the matches found, 
you may select individual items by pressing and holding the Ctrl key and clicking 
on any data desired.  You may also select a short range from the list by clicking 
once on an item, then moving down the list and pressing the Shift key and 
clicking on a second item.  All the data between the two items clicked on will be 
selected.  Click OK (Retrieve) once you have selected all desired data. 
 The <Print Report> button allows you to print out the data in a report 
without actually retrieving the data into the job. 
 <Cancel> exits the dialog without doing anything. 
 
 
 

Save to Database 
 
 The Save to Database command under the main Data menu allows any 
data read in from the instrument or imported from a file to be stored permanently 
into the current database. (This command is also available as a Tree View tollbar 
button and an option from the right-click menu. To do this, select all the data you 
wish to save and then click on this menu option.  A small dialog indicating Color 
iControl's progress in the save will appear.  Once that dialog box has vanished, 
the data will have been stored. 
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Create an Empty Data Base 
 
 This Data menu option allows you to create another database for storing 
measurements: primaries, samples, targets, colorants, substrates, etc.  Selecting 
this option will bring up a dialog box which allows you to create the database and 
give it a name.  If you wish to create a new database in a directory other than the 
one listed in the dialog box, you must close all open jobs and use Create an 
empty Database command under the File menu option to set Color iControl to a 
new default database directory. (Note: The File menu is only available when 
there are no jobs open.) 
 

 
 
 
 

Upgrade the Database 
 
 This Data menu command allows you to upgrade your database whenever 
you are upgrading the program. In many cases, newer versions of Color iControl 
will not be able to utilize data from an older database until the database is 
upgraded.  
 
 
 

Delete Data from the Database 
 
 This command from the main Data menu allows you to delete data from 
the database. Data may be deleted from the database in the same way that it is 
retrieved.  
 

33



Select the data type you wish to delete from the sub-menu.  A dialog box 
similar to the Recall from Database dialog will appear allowing you to specify the 
data you wish to delete.  If you use any search specifications, the Possible 
Matches dialog will appear.  Select the data you wish to delete and click on OK. 
 
 
 

Naming Conventions 
 
 This option brings up a dialog box which allows you to establish your own 
naming conventions in accordance with standard company or plant procedures.  
There are five fields which may be used to establish the naming conventions.  
You may enter information such as the dye lot, style, fabric, etc. The sum of all of 
the various parts of a name cannot exceed fifty characters. 
 In addition, several pre-defined attributes can be inserted into the name 
fields so that the program will automatically insert them as part of the name, 
including: <DATE>, <TIME>, <DATETIME>, and <SEQ>. The sequence value 
(<SEQ>) will automatically increase by one with every new read by the sensor. 
 If naming conventions are not established, the name prompt will be a 
single blank box into which you can type any alphanumeric name. 
 This dialog also allows you to define the label/prompt for the User Groups 
feature. The default values are Group 1:, Group 2:, and Group 3:. In addition, if 
you define the label/prompt for the First Group to be "STDNAME", then the first 
twenty characters of the standard name will be automatically entered into the first 
group field. See User Groups for more infomation. 
 The last item is the Name Trials field. This field allows you to enter a base 
name for each measurement. When the Read dialog is opened, it will 
automatically take the base name and append a sequence number to it. The 
sequence will always start with 0001 as the first sequence number. However, you 
may edit the number in the Read dialog's name field to another value the first 
time you take a measurement and the system will automatically pick up the 
sequence from that point on. 
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Import... 
 
 The import function allows importing data from a SLI-Scan system in a 
Datacolor ".EXP" formatted file, an ICS ".DAT" formatted file, or a ColorRite 
".QTX" formatted file. 
 Selecting the Import function brings up a dialog box to select the desired 
file. (See the illustration below.) Once the data is imported into the job, if you 
wish to store this data in the database, you must use the "Save to Database" 
command under the Data menu. 
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 Once you have selected the desired file for importation, click on the Open 
button.  A second dialog box will appear (see below).  This box displays the 
contents of the file you selected and allows you to select and import any or all of 
the data contained in the file. You may select the data type, the concentration 
units, as well as stripping the first or last formatted words off of the name. 
 You may also assign User Group designations for the imported data as 
well. 
 Click <Retrieve Selection> once you have made your choices. 
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User Groups 
 
 User groups are a feature designed to aid in the searching of the database 
and the recalling of data.  They allow any data to be placed into user-defined 
groups and sub-groups.  This allows you to search a portion rather than the 
entire database when looking for specific information.  The maximum number of 
groups any data item may belong to is three.  (Only three fields are provided for 
storing the user groups information along with the data item.)  User Groups are 
defined in the Formatted Name Setup dialog box accessed through the Configue 
Naming Convenetions command under the Data menu. 
 
 The user groups to which a data item belongs may be specified in several 
different ways.  First, there is a "Groups" button available in the Measure dialog 
boxes to allow you to specify data groups at the time measurements are taken.  
Second, the data Properties dialog box allows you to place the data item into any 
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user groups you wish merely by typing in the name of the groups in the fields 
provided.  Finally, you may place data into user groups whenever you import 
data from a file. 
 
 The most efficient way to utilize this feature of Color iControl is to develop 
a way of breaking down your data into logical groups.  For example, when storing 
colorant data, you may wish to use the User Group 1 field to specify the chemical 
class to which the colorant belongs, i.e., reactive, disperse, acid, etc.  Use the 
second user group field to break down the colorants further, identifying each of 
the colorants as high, medium, or low energy.  Another example might be to 
group substrates according to fiber type, cotton, wool, synthetic, etc.  You could 
then use the second user group field to identify each of the substrates based on 
whether it was a weave or a knit.  The possibilities are really endless.  The user 
groups allow you to design your own classification system for all of your data to 
improve access to the Color iControl database. 
 
 
 

Data Properties 
 
 When in the Quality Control mode of Color iControl, you may right-click on 
an item in the Job Tree View.  A menu will appear.  One of the available items 
will be "Properties."  Clicking on Properties will bring up a dialog box containing 
several tabs.  Each of the tabs contains different information about the data in 
question.  Some of the data types will contain more tabs than others.  Jumps to 
explanations of the various types of data properties displayed are provided 
below.  Colorants have their own unique properties and do not include the basic 
data properties information explained below.  
 
Basic Data Properties --- Click here to view the basic properties tabs which are 
included in all data properties dialog boxes, including: Standards, Trials, 
Substrates, and Primaries. 
 
Additional Properties of Standards --- Click here to view the tabs which appear in 
addition to the basic properties when examining the properties of standards. 
 
 
 
 
 

Basic Data Properties 
 
 There are three tabs which are always present in the first four data types 
(excluding colorants, which have their own special data properties).  These are 
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Name, Data Condition, and Spectral Data.  These three tabs will always be 
present when examining the properties of standards, trials, substrates, and 
primaries.  The Name tab of the Properties dialog is shown below.  Jumps are 
provided to information about the Data Condition and Spectral Data portions of 
the dialog. 
 
Data Condition ? Spectral Data
 

 
 
 

Data Condition 
 
 This tab will exhibit the various aspects of the instrument mode at the time 
the measurement in question was made. Ordinarily, these fields will automatically 
be filled in by Color iControl when the instrument is installed based on the 
program's communication with the instrument and the answers provided to the 
program by the person installing the sensor. These fields may change depending 
on the calibration mode selected for the sensor. See Select Mode for more 
information about calibration modes in Color iControl. 
 In addition, this tab contains a drop-down list which allows the selection of 
a Sample Mounting Procedure. Selecting a Sample Mounting Procedure for a 
standard will automatically cause Color iControl to prompt the user when reading 
trials with that information. For more information, see Setting Up the 
Measurement Process and Additional Elements of the Measure Dialog. 
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Spectral Data 
 
 This tab will allow you to examine or edit the exact spectral data gathered 
by the instrument.  The data will be displayed across the wavelength range of the 
instrument in ten nanometer increments.  The full wavelength range of the visible 
spectrum is represented here.  However, not all instruments measure the entire 
visible spectrum.  In our example below, you can see that the 360, 370, and 750-
780 are grayed out.  This means the instrument used to take this measurement 
did not include those wavelengths.  Color iControl copies the first and last 
measurement into these spaces as place holders.  This also prevents drop-offs 
whenever the data is displayed in a graph. 
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Additional Properties of Standards 
 
 Three additional tabs are included when examining the properties of 
standards: Stored Tolerances, Formula Editor,  and Tolerances Used.  The 
StoredTolerances tab is illustrated below.  Click on the jump provided to see the 
tabs on Tolerances Used or the Formula Editor. 
 
Tolerances Used  ?  Recipe/Formula Editor  ?  Advanced QC Settings 
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Tolerances Used 
 
 This tab will display the tolerances which are currently being used.  It has 
been included to help you keep up with where the current tolerances are coming 
from.  The source of each value is listed beneath each field.  You may not 
change any of these values from this screen; it is intended to be used for 
informational purposes only. The only actions you may take in this screen is to 
display tolerances for the different illuminants or to save the tolerances to the 
standard using the buttons provided. 
 

 
 
 

Recipe/Formula Editor 
 
 This tab allows you to edit formulas that have been stored with either the 
standard or a trial.  Formulas may only be stored with these two types of data.   
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Formula Name --- These fields allow you to specify which of four formulas stored with 
the standard you wish to view.  You may select the approved formula or one of the three 
alternatives. 
 
Selected Formula --- These fields display the currently selected formula. The buttons 
allow you to output the formula, edit it, or delete it. 
 
Substrate - Formula Editor --- The substrate will be listed here.  For multi-fiber 
substrates, the blend percentage will be included. 
 
Colorants - Formula Editor --- The colorants included in the formula will be listed here 
by name along with their concentrations. 
 
Items Not Found in this Job --- This portion of the dialog will display items related to 
this standard's formulas but not stored in the current job. 
 
Process Attributes - Fiber Type, Dye Class, Process --- These fields will display any 
process attributes associated with the formula when it was stored. You may use the 
drop-down lists to change the attributes for a stored formula. 
 
Copy current recipe to buffer --- This button copies the current recipe to a memory 
buffer for pasting into another recipe storage slot. This allows you to move recipes and 
formulas from one storage slot to another within the associated standard or trial's 
properties dialog. 
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Paste buffer to current recipe --- This button pastes the recipe stored in the buffer into 
the currently selected storage slot for a formula or recipe. This allows you to move 
recipes and formulas from one storage slot to another within the associated standard or 
trial's properties dialog. 
 
Apply factor to current formula --- This button and associated field allow you to enter 
and apply an overall correction factor to the currently displayed formula. 
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Spectro Management 
 

Install or Configure 
 
 This command is located under the Spectro menu and allows you to install 
a new instrument or configure the selected instrument. Clicking on this command 
brings up the Spectro Management dialog box illustrated below. 
 

 
 
From this dialog box, you may: 
 

•Install a new instrument using the Spectrophotometer Installation Wizard, a 
built-in utility which takes you through several dialog boxes prompting you for 
information about the instrument you are installing. 

•Modify an instrument's settings. This procedure also brings up the 
Spectrophotometer Installation Wizard. 

•Delete an instrument from the currently available list. 
•Change the mode of the current instrument or alter the comm port through 

which it communicates with the computer. 
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Jumps are provided below to topics containing detailed instructions for each of 
these options or you may click on the <Contents> button to return to the main 
help topics. 
 
Installing a New Instrument ‪ Select Mode ‪ Modifying an Existing Instrument ‪ 
Deleting an Instrument ‪ Calibrate ‪  

Installing a New Instrument 
 
 When installing a new instrument, begin by clicking once on the "Install 
New" button in the Sensor Management dialog box (See Install or Configure for 
more information). Doing this will bring up the New Spectro dialog box (illustrated 
below). Select the instrument you are installing from the list and click "OK." 
(Depending on the instrument, you may be asked for a calibration disk(s) that 
should have been provided with your sensor. If this is the case, follow the 
instructions on-screen before proceeding to the next step below.) 
 
 

 
 
 

 A second dialog box will appear, the Spectrophotometer Installation 
Wizard dialog (pictured below). Enter the name and serial number of the sensor 
you wish to install and click "Next." 
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 The third dialog in the installation process will appear, Choose Sensor 
Model (picture below). Click once on the drop-down list to see what models are 
available. Click once to select the model of the specific sensor you are installing. 
Click "Next" to continue. 
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 If you have an instrument which can measure wavelength ranges beyond 
the average instrument, you may get a dialog box (picture below) which allows 
you to select the wavelength range for the instrument you are installing. Enter in 
the desired range and click <Next>. 
 

 
 
 Once you have selected the instrument model and wavelength range, the 
next step is to choose the communication port connecting the sensor to the 
computer. Click on the radio button next to the comm port to which the 
instrument is connected. For instruments capable of communicating at different 
baud rates, you may choose the rate as well, although generally, the field will 
default to the correct rate. Click "Next" when you are done. 
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 If you had a calibration file for use with this instrument, then several other 
dialog boxes may appear displaying the calibration file data. Two examples of 
these dialogs are listed below displaying white tile values for specular included 
and specular excluded. 
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 Once you have selected the comm port and baud rate and reviewed the 
calibration file data, you are done. The "Installation Complete" dialog will appear 
(pictured below). Click on the "Finish" button to complete the installation. 
 
 

 
 
 Once the installation is complete, the Calibration Mode Properties dialog 
box will appear. This dialog is used to create different standardization modes for 
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the different types of measurements you may need. See Select Mode for more 
detailed information about creating and selecting different modes for use with 
your sensor. 
 

Modifying an Existing Instrument 
 
 You may modify certain aspects of a currently installed instrument by 
clicking once on the "Modify" button in the Spectro Manager dialog. (Click on the 
“Install or Configure…” command under the Spectro Menu to access the Spectro 
Manager.) 

 
Clicking on this button brings up the same set of dialog boxes as when 

installing an instrument (except for the initial dialog where you select the 
instrument to be installed). You may alter the name, serial number, model type, 
the comm port, and the baud rate. See Installing a New Instrument for examples 
of the dialog boxes and instructions. 
 

Deleting an Instrument 
 
 To delete an instrument from the Spectro Management dialog, simply 
select the sensor you wish to remove by clicking on it once. Then click once on 
the "Delete" button. That instrument will be deleted and no longer available for 
use. To use it again, you would have to go through the installation procedure. 
 

Changing the Mode of an Instrument 
 
 Changing the mode of an instrument means that you wish to take readings 
with different settings governing the way in which that instrument measures. The 
extent to which you can alter the mode of your instrument depends on the 
capabilities of that instrument. (Refer to your sensor's documentation for 
information about its full capabilities.) For example, your instrument's geometry 
cannot be altered; it will either be sphere, 45/0, or 0/45. However, you may have 
two different ports which can be attached to that instrument, one for large area 
view and one for small area view, depending on the type of samples you are 
measuring. Some instruments are capable of taking both reflectance and 
transmittance readings, while some will measure only reflectance. 
 Whatever the capabilities of your instrument, you may set up several 
different modes for making measurements and store them with a name so that 
you can easily switch from one mode to the other. For more information, see 
Select Mode. 
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Changing the Comm Port of an Instrument 
 
 From the Spectro Management dialog box, you may change the 
communcation port through which the instrument exchanges data with the 
computer. Clicking on the <Set Comm Port and Check Tile> button will bring up a 
dialog box containing the available comm port selections. You may select the 
comm port by clicking on the radio button associated with the desired comm port. 
 

Select Mode 
 
 This command from the Spectro menu will cause the Choose Calibration 
Mode dialog box to appear which allows you to select an operational mode for 
your instrument. (This dialog box is also available from the Spectro Management 
box by clicking once on the <Spectro Modes> button.) These modes must be 
defined and stored ahead of time. If you have not stored any mode specifications 
for your current instrument, you will have to do so before the instrument can be 
calibrated and used to take readings. 
 
To add a new mode, click once on the <Add New> button. The Calibration Mode 
Properties dialog box will appear (see second image below). This same dialog 
will also appear when you click on the <Modify> button to make changes to a 
mode.  
 
Not all the items in this dialog will be available for all instruments. Some 
instruments have more functionality than others. For more information, see the 
documentation provided with your instrument. 
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Calibration Mode Properties Dialog 
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This dialog is used to define the properties of the instrument for a specific 
calibration mode. For example, you may need to define two different modes, one 
for taking reflectance readings and one for taking transmittance readings.  
 
Enable Auto-configuration by spectrophotometer --- This checkbox enables 
the auto-configuration option. When checked, the current calibration mode 
properties will be ignored if changes are made to the spectro. For example, if the 
current mode is set for a small area view but the operator changes that to the 
large area view, the sensor will communicate that to Color iControl and the 
proper adjustments will be made.  
 
R/T Mode --- These three radio buttons allow you to select measurement type. 
The options are: Reflectance, Regular Transmittance, and Total Transmittance. 
 
Specular Condition --- These three radio buttons allow you to either include or 
exclude the specular component of the measurements. The third option, 
"Unknown," is for instruments where you are unsure of how they treat the 
specular component. 
 
Enabled NetProfiler --- This checkbox enables GretagMacbeth's internet-based 
instrument profiling software. 
 
Port Plate Aperture/Lens --- This drop-down list allows you to select the size of 
the measurement port for the mode being defined. A checkbox also allows you to 
instruct the program to ignore port plate errors. A checkbox also allows you to set 
the spectro to overilluminate the sample. 
 
UV Filter Pos/UV Energy --- These radio buttons allow you to set the location of 
the UV filter for those instruments so equipped. There are three options. "Out/UV 
Inc" instructs the program that the sensor should not filter UV when taking 
measurements. "Cal/UV Cal" instructs the program that the sensor has a filter 
which can be calibrated for UV when taking measurements. "In/UV Exc" instructs 
the program that the sensor should completely filter the UV component when 
taking measurements. To determine the UV capabilities of your sensor, see the 
instrument's documentation. 
 
Glass Correction Applied? --- Checking this box means that, for the mode 
being defined, samples will be measured behind glass so that a correction factor 
will need to be applied to compensate for the distortion the glass creates. 
 
Avg --- Generally when measuring color, several readings are taken and then 
averaged to create a single measurement. Enter the number of readings you 
wish the system to take and average to create a single measurement in this field. 
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A second field, deCMC Limit, allows you to place a limit on how different each 
reading can be from the average of all the readings; when this limit is passed, a 
warning will appear in the Read dialog box. This function is disabled if this field is 
left set to zero. 
 
Calibration Interval --- This field determines the amount of time allowed 
between calibrations of the instrument in the current mode. 
 
Your name for this mode --- This field allows you to name the different 
standardization modes defined for a particular instrument. Modes default to just 
being numbered if you do not name them with the first being zero. 
 

Calibrate 
 
 The instrument will need to be calibrated on a regular basis. You cannot 
take measurements without calibrating the spectro or if the most current 
calibration has expired. 
 Clicking on this menu option will bring up a small dialog box which will ask 
you to read a certain number of check tiles or a light trap. The exact number of 
tiles, their color, and the order you read them will depend on the type of 
instrument you have and how it is set up. (Generally, a light trap and a white tile, 
representing zero percent light and 100% light, are the minimum used in any 
calibration.) See the documentation provided with your instrument for more 
information about calibrating it. 
 Once you have read all the tiles requested, a final message box will 
appear informing you that the instrument has been successfully calibrated. 
 
Calibrating with a Colored Check Tile 
 
 GretagMacbeth highly recommends the use of a colored check tile during 
the calibration process. Generally, this tile will be green or blue. Taking this 
measurement in addition to using the light trap and a white tile helps to assure 
the accuracy of measurements made by the spectro. 
 Once the use of the colored check tile during calibration has been set up, 
the system will automatically prompt the user to read it after the light trap and 
white tile have been measured. In fact, the system will inform you that the 
calibration is complete through a small dialog box. When you click on the <OK> 
button to close the message dialog, the system will open the check tile file along 
with the Read dialog box. Instead of a name, the system will place the date and 
time into the name field. Place the colored check tile over the instrument port and 
take the reading. The measurement will be stored with the date/time information 
as its name into the top of the trial data in the tree view. (The measurement will 
be placed at the top of the trial portion of the tree view no matter how the system 
is set to store other measurements.) 
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 For more information about using the colored check tile option, see 
Calibrating with a Colored Check Tile. 
 
Calibrating the UV Filter 
 
 Some intruments have the capability to filter the ultra-violet portion of the 
spectrum for use when calculating the Whiteness Index of a particular standard 
or sample. For instruments so equipped, Color iControl has a routine which 
allows the filter to be calibrated. This requires a GANZ Whiteness standard or a 
CIE Whiteness standard, both of which should have been provided with the 
instrument. For more information, see UV Calibration Dialog. 
 

Calibrating with a Colored Check Tile 
 
 Color iControl has the ability to calibrate with a colored check tile. 
GretagMacbeth recommends using a third colored tile in addition to the light trap 
and white tile when calibrating the sensor. If the instrument fails when reading 
the colored tile, the calibration fails and no measurements can be taken. This 
helps to ensure that measurements made by the spectro are uniform, accurate, 
and stable over time. In addition, the check tile's measurements are stored in a 
file so that an historical record of the instrument's performance is maintained. 
This record can be of significant help when attempting to analyze problematic 
measurements or troubleshoot the instrument. 
 Jumps are provided below to topics containing instructions for using or 
disabling this option. 
 
Setting Up the Colored Check Tile Option ? Using the Colored Check Tile During 
Calibration ? Disabling the Colored Check Tile Calibration Option
 

Setting Up the Colored Check Tile Option 
 
 GretagMacbeth recommends using a colored check tile as part of your 
routine calibration procedure. You may select to enable the colored check tile for 
all modes or for only Mode 0. (See checkbox options in the image below.) This is 
done through the Sensor Properties box accessed through Sensor Management. 
The system will automatically use the name and serial number entered during the 
spectro installation process to construct a name for the check tile file using the 
form, "sensorname_serial#_0.job". Of course, the final element, "_0", will vary 
depending on the number of the mode you are creating the check tile file for. This 
filename will be displayed in the Sensor Properties dialog box in the field 
provided for it (see image below). However, at this point, only the filename has 
been created; the file itself still does not yet exist. 
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 You must edit the file prior to its being used; when you do this, the system 
will actually create the file.  
 

To do this, first be sure you are in the mode for which you wish to create 
the check tile file. Then, close all jobs and click on the "Open Check Tile Job" 
command under the File menu. 

 
The system will attempt to find the check tile job as it is listed in the 

Sensor Properties dialog. The standard "File not found" message will be 
displayed by the system. Close the message box by canceling it. 

 
At this point, the system will create the file and open it so that you may 

edit it for use. 
 

Editing the check tile file is simple and requires only one action: reading 
the colored checktile that came with your instrument and storing it as the 
standard in the job. This allows the system to compare the reading it takes of the 
colored tile during calibration with the measurement you make of the tile when 
installing the sensor. If the colored tile reading fails to pass within the specified 
DEcmc limit, the calibration will fail. 
 You will need to do this for all modes for which you need a colored check 
tile for calibration. 
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Disabling the Colored Check Tile Calibration Option 
 
 To disable the colored check tile option during the calibration process, you 
must open the Sensor Management dialog box using the "Install or Configure" 
command under the Sensor menu. 
 

At the bottom of the Sensor Management dialog is a button: <Set Comm 
Port and Check Tile>. Click once on this button to open the Sensor Properties 
dialog. 

 
At the bottom of the Sensor Properties dialog are two checkboxes, 

"Enable Check Tile for mode 0" and "Enable Check Tile for All Modes." One or 
both of these checkboxes should be selected (checked). Click once to deselect 
the check tile option you wish to disable. 
 
 Your sensor will no longer require reading the colored check tile as part of 
the calibration process for the mode(s) selected. 
 

Using the Colored Check Tile During Calibration 
 
 When actually calibrating the instrument, the colored check tile will be the 
last item measured. Clicking on the "Calibrate" command will first cause the 
program to prompt for a light trap, followed by the white tile. Once these two 
items have been measured, the program will display the "Calibration Complete" 
message. Click on <OK>. Immediately after you close the "Calibration Complete" 
dialog box, the check tile file will be opened automatically along with the Read 
dialog. Read the check tile using the normal read process. The check tile data 
will be placed into the check tile file. The Read dialog will remain open until you 
close it; this allows you to see the measurement that has been placed into the 
file. 
 

UV Calibration Dialog 
 
 Prior to calibrating the UV filter on the instrument, you must perform a 
normal calibration using the black and white tile. A colored tile may also be 
required depending on how the instrument has been set up. In addition to 
performing a normal calibration, you must also have the mode defined for 
calibrating the UV filter. This is done in the Calibration Mode Properties dialog. 
See Select Mode for more information. 
 Important Note: When calibrating for the UV component, only two 
calibrations will be necessary, one for the mode defined using LAV (large area 
view) and one for all other view size options. Even if you have two other modes 
defined requiring UV calibration (for example, one with medium area view and 
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one with small area view), you will only need to calibrate the UV for one of them 
since the calibration will be effective for all options other than LAV. 
 
 
Accessing the UV Calibration Dialog 
 
 To access the UV Calibration dialog box, open the Choose Spectro Mode 
dialog box either by clicking on the Sensor Mode button in the toolbar (white and 
black tiles with a small pencil and pad) or the "Select Mode..." command under 
the Sensor menu. From the Choose Sensor Mode dialog box, click on the 
desired mode to select it (this mode must be defined for calibrating the UV filter). 
Then, click on the <Modify> button. The Standardization Mode Properties dialog 
will open. At the very bottom right of this dialog is a button marked <UV 
Calibration.> Click once on this button. 
 
The UV Calibration Dialog Box 
 
 Once you have clicked on the <UV Calibration> button, the UV Calibration 
dialog box will open (see image below). 
 

 
 
 Depending on your instrument, you will either be using a Ganz Whiteness 
standard or a CIE Whiteness standard. Consult the documentation that came 
with your instrument to determine which standard you will be using. Once you 
have determined this, click on the appropriate radio button selecting the type of 
whiteness standard you will be using. The Ganz or CIE Whiteness value for your 
UV Whiteness standard should be provided with the standard; this value should 
be entered into the appropriate field at the top right of the dialog. The Tint field is 
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provided for those instruments which require a tint value in addition to the 
whiteness value for the UV standard. (Most instruments do not require this value; 
see your sensor's documentation to determine if yours does.) 
 
 The actual calibration procedure has two methods, Manual and Auto. 
 
 The Manual method uses the "Read White" button. Place your UV 
Whiteness standard over the instrument port and click once on the "Read White" 
button. 

 
A message will be returned informing you of the difference between the 

current Ganz or CIE value and the one entered at the top of the dialog. (Current 
GANZ or CIE whiteness values will be displayed in their appropriate boxes 
beneath the UV Filter Position field.) 

 
If this value is off by more than a few tenths, you should probably re-

calibrate. You may increase or decrease the position of the UV Filter to adjust 
before you perform another calibration. 

 
 The Auto-Calibrate option is easier and recommended. Simply place the 
UV Whiteness standard over the instrument port and click once on the "Auto-
Calibrate" button. 
 

The system will automatically attempt to match the Ganz or CIE 
Whiteness value entered, adjusting the filter a little bit with each try. Once the 
current Ganz or CIE Whiteness value closely approaches value established for 
the standard, you will be informed and a difference value will be displayed. (See 
the second image below.) 

 
 Press the "Accept" button to accept the calibration. 
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Measuring Data from the Instrument 
 
 Important Note: Prior to taking any measurements, the instrument must 
have been recently calibrated.  If not, you will be prompted to calibrate the 
instrument prior to taking any measurements. You must also have defined at 
least one operational mode for the instrument.  See the Spectro menu for more 
information about defining operational modes and calibrating the sensor. 
 
 Placing the mouse cursor over the "Measure with Spectro..." option under 
the Data menu will cause a small second popup menu to appear allowing you to 
select the type of data you wish to measure.  Only four types of data may be read 
into Color iControl from the instrument: standards, trials, substrates, and 
primaries.   
 

Choosing to measure data for any of these data types will bring up a 
dialog box.  Of course, when reading trials, the dialog will say "Measure Trial."  
When measuring substrates, the dialog will say "Measure Substrate," etc.   In 
these instructions, the generic term "sample" will be used to refer to all the 
different types of measurements being made even though the images being 
referred to will contain a specific reference to reading a standard. 
 
See Measuring Data: The Process for more information. 
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Setting up the Measurement Process 
 
 Color iControl offers many special settings governing the behavior of the 
system when taking measurements. These settings are located in the General 
tab of the Settings dialog and in the tab marked Options. They allow you to set 
the system to automatically store measurements to the database, enter 
comments for each reading, auto-accept standards, as well as turn on the name 
formatting function, among others. 
 
Name Formatting 
 Name formatting is another element of the system's operation which must 
be decided upon prior to taking any measurements. Name formatting allows 
users to specify each sample's name as a series of entries rather than as one 
name. For example, you may include in each standard's name information 
conveying the style, color, and substrate for that item. Each of these names will 
have to be entered separately at the time of the sample's measurement. 
However, they can also provide much more flexibility when searching the 
database by allowing you to search only for those sample with a specific style, 
color, etc. See Naming Conventions for more information. 
 
User Groups 
 Deciding whether or not you will use the User Groups function is also 
important prior to beginning your measurements. User Groups allow users to 
enter up to three fields of information about each measurement. These fields are 
stored with the sample and may be used to restrict searches of the database.  
For more information, User Groups. You will not need to set anything in the 
software for this option; the <Groups> button is always available when reading 
data. However, you will need to decide upon a consistent usage strategy for this 
option should you decide to implement it. 
 
Sample Mounting Procedure 
 Another element that will need to be set up by the user is the Sample 
Mounting Procedure. The way in which a sample is mounted can affect the 
measurement greatly. When comparing standards and trials, they should always 
be measured using the same Sample Mounting Procedure. To enable the 
Sample Mounting Procedure for a particular standard, open that standard's 
Properties… dialog and click on the Data Condition tab. The Sample Mounting 
Procedure drop-down list-box is located at the lower right portion of the dialog. 
Select from among the options. Once the procedure is defined for the standard, 
Color iControl will always prompt you with which procedure is being used and 
request that you select the procedure to be used for any trial measurements. See 
Sample Mounting Procedure in Additional Elements of the Measure Dialog for 
more information. 
 
Extended Measurements 
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 In addition, some items in the Standard/Multi-Trial view cannot be 
calculated unless measurements are taken in a special way using a specially 
defined calibration mode. See Extended Measurements in Additional Elements of 
the Measure Dialog and Select Mode  for more information. 
 
 

Measuring Data: The Process 
 
 The instructions for taking measurements below are of the basic 
measurement process. Some variation may exist due to selections made in the 
General or Options tab of the Settings dialog. In addition, sample names are 
treated as if Name Formatting is not selected for use and the calibration mode of 
the spectro does not include Extended Measurements.  
 
Reading Data 
 
 1.  Click once on the Data menu. 
 
 2.  Place the mouse cursor over the "Measure with Spectro" option. The 
sub-menu will pop-up. 
 
 3.  Click once on the  "Measure Standard" option. 
 
 4.  The Measure Standard dialog box will appear. (See illustration below.) 
The cursor will be in the "Full Name" field. Once you have entered the sample 
name and specified any user groups, simply press Enter (or Next) to begin 
measurement.  You should receive a "...Read in Progress..." message. 
 

 
 
 5.  If a number of measurements to average was set for the 
standardization mode in the Standardization Mode Properties box, the prompt 
will change to "Reading 2 of x; Press <Enter> to read," where x is the total 
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number of measurements to average.  Press Enter (or Next) again.  The "...Read 
in Progress..." message will reappear. 
 
 6.  Repeat for as many measurements as necessary. 
 
 7.  When the number of readings necessary for the average have been 
taken, you will receive your final prompt: "Press <Next> to accept reading, or 
<Reset> to discard."  The measurement will be added to the tree view in the 
current job. 
 

Additional Elements of the Measure Dialog 
 
 Depending on the settings you have specified for taking measurements 
with the spectro, you may see variations in the Measure dialog box. The 
available variations are listed below with an illustration and a brief explanation. 
 
Standard Tolerances 
 When measuring standards, an additional button will be available in the 
measure dialog allowing you to set the tolerances governing what is and is not an 
acceptable match to that standard (see illustration below).  Clicking on this button 
will cause the Standard Properties dialog box to appear.  Tolerances may be set 
from this dialog.  This option will not be available if you have "Auto-Accept 
Standards" checked in Options tab of the Settings dialog. 
 

 
 
 
Length 
 When measuring trials, you may set the program to prompt for a length 
value if you wish (see illustration below). This length value will be in whatever 
units have been selected for use by the system. The "Length" field will appear in 
the lower right corner of the dialog. For the program to be set to prompt for 
length, a checkbox must be selected in the Options tab of the Settings dialog 
box. 
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Percent 
 When measuring primary data, the system will automatically prompt you 
for the percent value for that primary sample at the conclusion of the 
measurement but before closing the measure Primary dialog. A field marked 
"Percent" will appear after the last reading so that you may enter in the percent 
value. 
 

 
 
DEcmc Limit 
 You may also define a dEcmc limit on each measurement when compared 
to the average of all the reads taken for any single measurement. (This dEcmc 
limit is defined as part of the mode. See Select Mode for more information.) If this 
limit is exceeded, then a warning will be displayed in the measure dialog (see 
image below). In addition, a button marked "More Info" may be clicked on to 
determine how many reads exceeded the dEcmc limit (see an example of this 
dialog in the second image below). 
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Comment Field 
 You may enter a comment (maximum 254 characters) which will be stored 
with the sample's Properties. This option must be turned on (selected) in the 
Options tab of the Settings dialog. The Comment field will appear immediately 
after you have entered the sample name (See illustration below.) Comments are 
entered in the same box as the sample's name, but the field ID will change to 
indicate that you are entering a comment. 
 

 
 
 
Averaging and Auto-Averaging 
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 You may automatically average a set of trial measurements if needed by 
checking the "Auto-Average Trials" item in Options tab of the Settings dialog. 
Doing this will set the program to automatically average every trial measurement 
made until you click once on the <End Avg> button which appears in the lower 
right corner of the measure dialog (see figure below). 
 Even if you do not have the Auto-Average option enabled, you can still 
average any measurements you make by clicking once on the <Begin Avg> 
button which is available in the measure Trial dialog box (see second figure 
below). Clicking on this button starts the averaging process; the button will 
change to the <End Avg> button. Click on that when you have measured all of 
the trials you wish to average. 
 Closing the measure dialog (in the case of Auto-averaging) or clicking on 
the <End Avg> button (in the case of Averaging) will cause an abbreviated 
properties dialog to open. This dialog will only have a Name tab and represents 
properties of the average. The default name for the averaged  measurement will 
be "Averaged Data." Once you close this dialog, the average will appear at the 
bottom of the trials portion of the Tree View. 
 

 
 

 
 
Sample Mounting Procedure 
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 You may also include the sample mounting procedure for each trial. If a 
Sample Mounting Procedure has been defined for the standard, then the system 
will automatically prompt the user with a small dialog box (see below) identifying 
the procedure used for the standard and allow him to select a procedure for 
measuring the trials. For more information, see Setting Up the Measurement 
Process. 
 

 
 
 
Extended Measurements 
 
 Some items in the Standard/Multi-Trial view attributes require special 
measurements in order for their value to be calculated. For example, opacity 
requires that a sample be measured over a dark backing and a white backing. In 
order to enable these measurements, you must define them as part of the 
calibration mode. See Select Mode for more information. Once the calibration 
mode is defined by the system and the appropriate item selected for display in 
the Standard/Multi-Trial View, the Read dialog will prompt the user for the 
extended measurements. 
 

Timed Measurements 
 
 The system may be set to take measurements at set intervals by using the 
"Timed Measurements" command in the "Measure with Spectro" sub-menu under 
the Data menu. You should open a new job for this operation. 
 

Clicking on this option will open a small dialog box which allows you to 
enter a base name for the timed measurements and the interval at which to take 
the readings. Once you have entered the name and interval, click on <OK> to 
start the timed reads. 
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This option is primarily intended for diagnostic use when troubleshooting 
the instrument. 
 

Upload Data from a Portable Spectrophotometer 
 
 This command allows you to upload data stored in the memory of a 
portable spectrophotometer. Selecting this option causes the standard import 
data dialog box to appear with a list of measurements uploaded from the 
spectrophotometer (see image below). 
 You may select which measurements you wish to retreive just as you 
would when importing data from a file or the database. Select the data you wish 
to upload by clicking on it. Multiple, non-sequential items may be selected by 
clicking on them while simultaneously holding down the <Ctrl> key. If you wish to 
select a sequence of items, select the first item with the mouse, then select the 
last item in the range while simultaneously holding down the <Shift> key; all the 
items between the first and last sample will then be selected. You may select all 
the items by clicking once on the <Select All> button. Click once on the <Retrieve 
Selection> button to load the uploaded data into the current job. 
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 In addition, you may specify User Groups and the Data Type for the 
selected data as well. You may specify different a different data type for storage 
in the database as opposed to storage in the current job. 
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Color Difference/How To 
 

Display Data in Views 
 
Data is selected for display in the Tree View. (For more information, see Tree 
View in the Quality Control topic.) All data currently loaded into the job will be 
displayed in the Tree View; however, not all data loaded into the job will be 
displayed in the data views. To view data in the various views, you must select it 
for display. 
 
The easiest way to select data is to use the “Show All” button (See figure below) 
from the Tree View toolbar. This command is also available in the Tree View 
right-click menu.  
 

 
 
Clicking once on this button will automatically select all data from the Tree View 
for display in the other views. The figure below shows the Tree View before and 
after selecting the data for display. Notice that the data type icons (the target and 
dart images) are greyed out before the data is selected but are displayed in color 
afterwards. 
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If you wish to select only a portion of the items displayed in the tree view, you will 
need to manually highlight the desired items using the mouse prior to selecting 
them for display.  
 
Manual Selection: To manually highlight the data you wish displayed, left-click on 
individual items with the mouse while holding down the <CTRL> key. This 
method is best used when you only have a few items to view. You may highlight 
mulitiple items by selecting a range. To do this, left-click on the first item, then 
hold down the <Shift> key and left-click again on the last item. Every item 
between the first and the last will be highlighted. 
 
Once you have manually highlighted the desired items, click once on the <Show 
Only> button in the Tree View toolbar (See figure below). This command is also 
available as an item in the Tree View Right-Click menu. 
 

 
 
 
 
 

View Color Difference Data 
 
The main view for displaying color difference data is the Standard/Multi-Trial view 
(see image below). Items in the Standard/Multi-Trial view are known as 
attributes. If you need to save space, you may exclude the standard’s information 
by deselecting the “Show standard info” option in the view’s right-click menu. 
 

 
 
To display a particular attribute, you must select it for display through the 
Standard/Multi-Trial view’s Properties… dialog (see figure below.) To access this 
dialog, right-click once in the view with the mouse and click on “Properties…”. 
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Notice that there are two radio buttons at the top left. These determine whether 
you are selecting attributes for the standard display or for the trial display. 
 
Below the standard/trial radio buttons are two display areas: Possible Attributes 
and Selected Attributes. To move an item from the Possible Attributes box to the 
Selected Attributes box, click once on the item to highlight it. (You may select 
multiple items using <Ctrl> click or a range by using <Shift> click.) 
 
Once the desire item is highlighted, click on the right-facing double arrow button 
between the two boxes. This will cause the item to move from “possible” to 
“selected.” 
 

73



Once the item is in the “Selected Attributes” box, it may be moved up and down 
by using the buttons to the right. Selected attributes are displayed in their top-
down order in the Standard/Multi-Trial view from left to right. 
 
 
 
 
 

Change Views/Edit a View’s Properties 
 
 
Any of the data views in Color iQC can be changed except for the Tree View. 
The Tree View cannot be moved or replaced with another view. For a complete 
list of data views, see the Quality Control topic. 
 
To change a view, right-click once in that view to open that view’s pop-up menu. 
Select the “Change View” option. The current view will be replaced with the view 
selected. 
 
To edit a view’s properties, right-click once to open that view’s pop-up menu. 
Select the “Properties…” option. A dialog box containing the available options for 
altering the display of that view will open. You may make selections and then 
click <OK>. The display of the view will be changed according to your selections. 
 
For more information on the properties of the various views, see the topics on 
each view available through the Quality Control topic. 
 
 
 
 

Print Color Difference Data 
 
Color difference data may be printed out in two ways, by printing an individual 
view or by including a view in the Full Printout option. 
 
To print an individual view, right-click once in that view to open the pop-up menu. 
Select the Print option. 
 
The Full Printout option is available through the Print button on the toolbar (See 
figure below) as well as the “Print” option under the Job menu. Clicking on this 
button or selecting the “Print” command will send a print job to the printer. Only 
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the views where the “Include in Full Printout” option in the right-click menu has 
been checked will be included in the print job. 
 

 
 
Color iQC also includes a “Print Preview” option under the Job menu that allows 
you to view what the output will look like prior to actually sending the print job to 
the printer. Simply click on the “Print Preview” option and a dialog will open 
allowing you to examine the output. You may browse the pages of the job, zoom 
in or out, and print from this dialog. 
 

Attributes for Standard/Multi-Trial View Display 
 
 Color iControl has a wide variety of possible attributes available for display 
for either the standard or any trial data loaded into a job. Following is a complete 
list, with brief definitions, of each of those attributes. This list is comprehensive 
and includes attributes for both Standard and Trial display; however, not all of 
these attributes will be applicable to the standard (delta values, for example).  
 
Available Attributes 
 
L* --- Represents a standard or sample's position on the lightness axis in either 
CIELAB or CIELCH color space. This attribute is also available in Strength 
Adjusted form. 
 
a* --- Represents a standard or sample's position on the green/red axis in 
CIELAB color space, green being in the negative direction and red being in the 
positive direction. This attribute is also available in Strength Adjusted form.  
 
b* --- Represents a standard or sample's position on the blue/yellow axis in 
CIELAB color space, blue being in the negative direction and yellow being in the 
positive direction. This attribute is also available in Strength Adjusted form.  
 
C* --- Represents a standard or sample's chroma value in CIELCH color space. 
This attribute is also available in Strength Adjusted form. 
 
h* --- Represents a standard or sample's hue value in CIELCH color space. This 
attribute is also available in Strength Adjusted form. 
 
X --- Represents a standard or sample's X tristimulus value for the 1931 CIE XYZ 
color space.  
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Y --- Represents a standard or sample's Y tristimulus value for the 1931 CIE XYZ 
color space.  
 
Z --- Represents a standard or sample's Z tristimulus value for the 1931 CIE XYZ 
color space.  
 
x --- Represents a standard or sample's position on the horizontal axis in the 
chromaticity diagram. 
 
y --- Represents a standard or sample's position on the vertical axis in the 
chromaticity diagram. 
 
L --- Represents a standard or sample's position on the lightness axis in Hunter 
color space. This attribute is also available in Strength Adjusted form. 
 
a --- Represents a standard or sample's position on the green/red axis in Hunter 
color space. This attribute is also available in Strength Adjusted form. 
 
b --- Represents a standard or sample's  position on the blue/yellow axis in 
Hunter color space. This attribute is also available in Strength Adjusted form. 
 
Whiteness Index (ASTM, CIE, GANZ) --- The Whiteness Index of a standard or 
sample can be calculated by either the ASTM method, the CIE method, or the 
GANZ method.  
 
Yellowness Index --- The Yellowness Index of a standard or sample. This 
attribute is calculated using the ASTM E313.  
 
Tint (CIE, GANZ) --- The Tint of a standard or sample can be calculated using 
either the CIE method or the GANZ method. 
 
Single Wavelength %R --- This value displays the wavelength used for 
calculation of the Color Value/Strength using the Single Wavelength method. The 
wavelength to be used for this can be entered into the Properties dialog of the 
standard (field marked "SWL for Strength"). If no value is entered into this field, 
then the system will default to using the minimum wavelength for calculating this 
value. 
 
Color Value (WSUM, SUM, SWL) --- The Color Value is a single numerical value 
related to the amount of color absorbing material (colorant) contained in a 
sample. It is most often used to calculate the difference in strength (% strength) 
between two colored specimens. Color Value may be calculated by any one of 
three acceptable methods: WSUM, SUM, and SWL.  
 
Minimum Wavelength --- This attribute identifies at which wavelength the least 
amount of light is reflected from your sample and its percent reflectance value. 
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This attribute will always display the minimum wavelength regardless of what the 
value "SWL for Strength" is set to in the standard's Properties dialog box. 
 
Date/Time --- Displays the day and time that the measurement was taken. 
 
Comment --- This option allows you to display any comments entered into the 
Comment field in the measurement's Name tab of its Properties... dialog box.  
 
Haze --- Calculation requiring extended measurements TRA/TRA. Correlated 
Haze requires measurement of transmission using a white then a black trap. See 
Extended Measurements in Setting Up the Measurement Process and Additional 
Elements of the Measure Dialog for more information. See also Calibration Mode 
Properties Dialog in Select Mode. 
 
 
Opacity_CR --- This value is the opacity using the contrast ratio method. To use 
this value, the calibration mode of the spectro must include extended 
measurements for over light and over dark. Samples must then be measured 
using both a light backing and a dark backing. See Extended Measurements in 
Setting Up the Measurement Process and Additional Elements of the Measure 
Dialog for more information. See also Calibration Mode Properties Dialog in 
Select Mode. 
 
Berger_WI --- This Whiteness Index is specified for illuminant C and 2 degree 
observer; however, it is commonly used with other illuminants and observer 
functions. The value displayed will depend on the selected illuminant and 
observer function. 
 
Stensby_WI --- This Whiteness Index is for use in HunterLab color space with 
the Hunter color co-ordinate values. 
 
Taube_WI --- This Whiteness Index is specified for the illuminant C and 2 degree 
observer; however, it is commonly used with other illuminants and observer 
functions. The value displayed will depend on the selected illuminant and 
observer function. 
 
Tappi_452 --- This Brightness Index is typically used only in the paper industry 
for evaluating the quality of untreated pulp, paper, and paperboard. It is not 
recommended for evaluating the normal color appearance of whites, especially if 
fluorescent agents are present. 
 
Tappi_525 --- This Brightness Index provides a measure of the diffuse 
brightness of pulp. Diffuse reflectance is measured at an effective wavelength of 
457 nm. It is not recommended for evaluating the normal color appearance of 
whites, especially if fluorescent agents are present. 
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OJ_Index --- This index was developed by the U.S. Department of Agriculture for 
use with the GretagMacbeth Color-Eye 2020+ or GretabMacbeth Color-Eye 3000 
spectrophotometers equipped with an orange juice test tube holder accessory. 
 
Munsell HVC Notation --- This item will display the Munsell Hue Value Chroma 
notation for the sample. 
 
SRR Gloss --- ASTM method E429 Specular Reflectance Ratio gloss calculation 
for sphere spectrophotometers using Specular included versus Specular 
excluded measurements. SRR Gloss requires Extended Measurements.  
 
Oper ID --- This attribute displays the operator ID for the measurement, ie, the 
person who took the reading. 
 
Gloss 60* --- This attribute displays a correlated 60 degree gloss method using 
SCI/SCE measurement and an equation that correlates the differences to 
measurements taken on a true 60 degree gloss meter. Gloss 60* requires 
Extended Measurements. See Extended Measurements in Setting Up the 
Measurement Process and Additional Elements of the Measure Dialog for more 
information. See also Calibration Mode Properties Dialog in Select Mode. 
 
 
DL* --- The delta value for the L* attribute. This attribute is also available in 
Strength Adjusted form. 
 
Da* --- The delta value for the a* attribute. This attribute is also available in 
Strength Adjusted form. 
 
Db* --- The delta value for the b* attribute. This attribute is also available in 
Strength Adjusted form. 
 
DC* --- The delta value for the C* attribute. This attribute is also available in 
Strength Adjusted form. 
 
Dh* --- The delta value for the h* attribute. This attribute is also available in 
Strength Adjusted form. 
 
DE* --- The distance a sample falls from the standard in CIE color space using a 
simple, straight-line calculation. This attribute is also available in Strength 
Adjusted form. 
 
DEcmc (2.0:1) --- This value also represents the distance in color space that a 
sample falls from the standard but is calculated using the CIE DEcmc equation 
which includes weighting functions that predict visual acceptability more 
accurately than the simpler DE* calculation. This attribute is also available in 
Strength Adjusted form. 
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DL --- The delta value for the L component of Hunter color space. 
 
Da --- The delta value for the a component of Hunter color space. 
 
Db --- The delta value for the b component of Hunter color space. 
 
DEh --- The distance a sample falls from the standard in Hunter color space. 
 
DLf --- The delta value for lightness in FMC-II color space. 
 
DRGf --- The delta value for the red/green value in FMC-II color space. 
 
DYBf --- The delta value for the yellow/blue value in FMC-II color space. 
 
DCf --- A delta value representing total chromatic color difference in FMC-II color 
space. 
 
DEf --- The delta E value for the FMC-II color space. 
 
DL*00 --- The delta value for the L* attribute from a proposed new color space. 
This attribute is also available in Strength Adjusted form. 
 
DC*00 --- The delta value for the C* attribute from a proposed new color space. 
This attribute is also available in Strength Adjusted form. 
 
DH*00 --- The delta value for the H* attribute from a proposed new color space. 
This attribute is also available in Strength Adjusted form. 
 
DL*cmc --- The delta L* weighted by the CMC equation. This attribute is also 
available in Strength Adjusted form. 
 
DC*cmc --- The delta C* weighted by the CMC equation. This attribute is also 
available in Strength Adjusted form. 
 
DH*cmc --- The delta H* weighted by the CMC equation. This attribute is also 
available in Strength Adjusted form. 
 
Gray Scale for Staining --- This attribute displays the Gray Scale value for 
staining between the standard and a sample. 
 
Gray Scale for Color Change --- This attribute displays the Gray Scale value for 
staining between the standard and a sample. 
 
Metamerism Index (1,2; 1,3; 2,3) ---This attribute display the Metamerism Index 
between either the first and second (1,2), the first and third (1,3), or the second 
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and third (2,3) illuminants. You may set which illuminants Color iControl 
considers first, second, and third in the Illuminants section of the Settings dialog 
box. This attribute is also available in Strength Adjusted form. Metamerism is 
also an attribute on which you may sort formulas when in Color iControl's 
formulation mode and can be selected from that mode's Settings dialog.
 
Pass/Fail/Margin --- This item displays a pass, fail, or marginal indicator for 
samples measured against the standard. It must be selected in order for the 
pass/fail/marginal icons (green ball, stop sign, yellow question mark, 
respectively) to be displayed in the Standard/Multi-Trial view. 
 
Sort Codes (DL*C*H*, DL*a*b*, DLab) --- This attribute displays the 555 Sort 
Codes for the selected samples compared to the standard. You may select Sort 
Codes for DL*C*H*, DL*a*b*, or DLab. Also available in Strength Adjusted form 
for the DL*C*H* and DL*a*b* sort codes.. 
 
Strength (WSUM, SUM, SWL) --- This attribute displays the relative difference in 
strength between a standard and a sample. This calculation employs the Color 
Value of each of the specimens so that you have a choice as to how that Color 
Value is calculated, WSUM, SUM, or SWL. 
 
DY --- The delta value for the Y element of the chromaticity diagram. 
 
Dx --- The delta value for the x element of the chromaticity diagram. 
 
Dy --- The delta value for the y element of the chromaticity diagram. 
 
Group/Sequence --- This attribute will only be available if you have purchased 
the SLI-Taper/W32 option with your Color iControl system. It identifies each 
sample's place in a set(s) of tapered samples. If more than one group was 
tapered with a data set, then the groups will be identified as well as the 
sequence. 
 
Group_1, Group_2, Group_3 --- These attributes allow you to display any User 
Groups that the sample has been included within. See User Groups for more 
information. 
 
Length --- This attribute displays the length of the fabric in whatever units have 
been selected by the user. You can set the program to prompt for a length value 
whenever you do an instrument read in the Options tab of the Settings dialog 
box. 
 
Str Adjusted --- This attribute appears before many of the colorimetric terms 
previously listed and allows you to display those terms in their strength adjusted 
form. That is, Color iControl corrects the sample(s) so that its strength is equal to 
the standard. Then color difference data is calculated again. Strength adjusted 
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data is helpful in determining whether or not correcting only for strength 
differences will result in a hue shift. Terms that are available in Strength Adjusted 
form are so indicated. 
 
Color Inconstancy --- This attribute indicates a color change in the sample 
(without any reference to the standard) under different illuminants. This property 
is sometimes known as "flare." You may select to display a Color Inconstancy 
value for samples for the first and second illuminants, the second and third 
illuminants, and the first and third illuminants. This is a new index for which 
experimental data has not been gathered and therefore no hard and fast rules on 
acceptable tolerances have been established. Higher values of Color 
Inconstancy (over 1.0) probably indicate an unacceptable color difference; 
however, it would be wise to also examine the trial measurement in question in 
the Color Rendering View with the Multiple Illuminants option turned on to 
examine the color change visually rather than depending purely on the numeric 
value listed in the Multi-Trial View. Color Inconstancy is also an attribute on 
which you may sort formulas when in Color iControl's formulation mode and can 
be selected from that mode’s Settings dialog. 
 
Roll-Roll DEcmc --- This item displays the DEcmc from roll to roll when the SLI-
Taper software is used to sequence a set of measurements depicting rolls of 
fabric. 
 
sR, sG, sB --- These attributes allow you to display RGB values as given in 
SRGB color space. 
 
Tappi_Opacity --- This index is a measure of opacity (sometimes called hiding 
power or contrast ratio). It is the ratio of Y tristumulus for the sample measured 
over a black substrate divided by the Y tristimulus for the sample measured over 
a white substrate, expressed as a percentage. This calculation is based on the 
1931 standard observer (2 degree) and Illuminant A. 
 
APHA --- This attribute is defined by the American Public Health Association for 
determining color (clarity) of water. 
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Formulation/How To 
 
 

Preliminaries to Formulation 
 
All instructions for formulation asume that the proper data has been loaded into 
the job from the database or measured from the spectrophotometer.  
 
See Data Management for information about recalling data from the database. 
See Spectro Management for information regarding measuring data with the 
specro. 
 
 

Viewing Data in the Formulation Application 
 
The Formulation application has a variety of ways to set up the screen views 
depending on your formulation needs. Two screen setups are included as 
defaults by using a button to toggle between Single Target and Multi-Target.  
 
The Single Target configuration is shown below. 
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The Multi-Target configuration is shown below. 
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Other configurations are available using additional views not displayed in the two 
defaults. All options are shown below. To view the additional data views in the 
Formulation application, you will need to use the mouse and click and drag at the 
edges of the various views to size them according to your needs. 
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Formulating for a Single Target 
 
The simplest method to formulate for a single target is to do it from the QC mode. 
Select the target and the substrate for display in the QC views. The system will 
automatically select the colorants. 
 
Once all items are displayed in the QC views, click once on the Formulation 
button in the Tree View toolbar. (If you do not see this button, you will need to 
add it to the toolbar by right-clicking and selecting “Manage Buttons” from the 
pop-up menu.) 
 

 
 
The software will automatically change to the Formulation application screen and 
display the optimum formula calculated by the system. Information on columnar 
data listed with the formula can be found in the Viewing and Evaluating 
Formulation Results topic. 
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If you wish to view all of the formulas calculated by the system, click once on the 
“Show All” button. This button opens the Formula List view containing all 
formulas calculated by the software. 
 
 
 
 

Formulating for Multiple Targets 
 
 
To formulate for multiple targets, click on the Formulation application button in 
the main toolbar (see image below). 
 

 
 
Once the system has arrived at the Formulation application screen, make sure 
that the screen is set-up for multiple target formulation. It should appear like the 
image below. 
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Select the desired targets, colorants, substrate, and resins by clicking in the 
checkboxes. You may click once on the column header to select all targets. In 
addition, make sure that only one substrate is selected since the formulation 
process can only calculate formulas for one substrate at a time. 
 
Once the desired settings are selected, click once on the <Formulate> button. 
The system will calculate formulas for each target with the optimum formula 
displayed for each. Information on columnar data listed with the formula can be 
found in the Viewing and Evaluating Formulation Results topic. 
 
If you wish to view all formulas calculated by the system, click once on the 
<Show All> button to open the Formula List view. 
 
 
 

Viewing and Evaluating Formulation Results 
 
Whether you are using Single or Multiple Target formulation, formulas will be 
listed with the columnar data options selected in the Formula Display tab of the 
Formulation Settings dialog. 
 
Clicking on the <Show All> button to open the Formula List View (a.k.a. Formulas 
Editor or Formula Display) allows you to examine the other formulas calculated 
by the system. 
 
The system defaults to displaying what is called the “Optimum formula” in the 
main Formulation Screen. This formula is marked with a special star icon (see 
image below.) 
 

 
 
This “Optimum formula” is calculated by the system the settings in the Optimum 
Score tab of the Formulation Settings dialog. 
 
When storing colorants, they may be marked as either Preferred, Normal, or Use 
Only If Required. As far as evaluating the optimum formula, the system will 
always use Preferred colorants over Normal, Normal over Use Only If Required. 
You may select in the Formula Display Settings dialog which formulas you want 
to see in the Formula List View, i.e., those formulas only using Preferred 
colorants, those using Preferred and Normal, or those using all three; but, this 
selection will not affect the calculations used to determine the optimum formula. 
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The formula preference aspect of formulation is displayed in the Formula List 
view through the use of different colored formula ticket icons placed in the far 
right column beside each formula listed. Formulas using only "preferred" 
colorants will have a yellow icon beside them as well as a lowercase "p". 
Formulas using one or more "normal" colorant(s) will be listed with a green icon. 
In addition, a separate sort column titled "Score" lists formulas according to the 
formula preference calculations (lowest score is best). 
 
You may decide to simply accept the program's recommendation or you may 
decide to examine the other formulas along with their sort criteria and formula 
preference and find another formula you may wish to use. The column headers 
at the top of the sort criteria columns allow you to resort the formulas merely by 
clicking once.  The currently selected sort criteria can be identified by the 
presence of a plus or minus sign to the left of the column header.  The formulas 
may be sorted in ascending or descending order for any of the sort criteria.  The 
plus or minus sign indicates whether the best or worst formulas, according to that 
criterion, are at the top of the list, plus for the best formulas, minus for the worst. 
 

Examining Formulation Results Graphically 
 
The graphic views in both the Formulation Screen and the Formula List view can 
display any one of three graphic options: Predicted Performance, Spectral Plot, 
or Color Rendering. 
 
When displaying a formula's Predicted Performance, remember this graph is 
generated from the Predicted Performance Variation percentage value as set in 
the Formula Display tab of the Settings dialog.  The graph shows the full range of 
possible variations in color for the selected formulas.  The three ellipses are 
located 0.5, 1.0, and 1.5 DEcmc from the origin.  Generally, any formula whose 
graph remains within the yellow ellipse (1.0 DEcmc) will be a good formula. 
 
When displaying a formula's Spectral Data, three curves will be shown: the 
substrate (maroon), the target (red), and the formula (pink). 
 
Color Rendering displays an accurate on-screen rendering of both the target and 
the selected formula's color under all three of the selected illuminants (in 
descending order, 1st, 2nd, 3rd; illuminants are selected in the Color iControl 
General Settings.) 
 
 

Storing a Formula 
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 Formulas may be saved by selecting a formula, right-clicking once, and 
selecting the "Save Formula Number" option from the menu.  A dialog box will 
appear. The standard or trial with which the saved formula will be associated is 
listed at the top of the box.  Below the name, you have four options, the 
Approved Recipe and three possible Alternate Formulas.  (These are the 
formulas that will appear in the Recipe/Formula Editor tab of the Standard 
properties dialog box.)  You may save up to four Blend Components under each 
section (i.e., four different formulas calculated for different substrates).  Once you 
have stored the formula, the name of the substrate used in that formula will 
replace the title "Blend Component." 
 The Recipe Name at the bottom of the dialog allows you to rename the 
Alternate Formula fields to a more specific title.  This allows you to store formulas 
slightly different than the approved formula in order to service individual customer 
needs.  If you wish to use these fields, click once on the Blend Component 1 
under Alternate 1 (this field may be called "empty", depending on which program 
release you have).  The Recipe Name field will light up and contain the phrase 
"Alternate 1."  Click once with the mouse in the box to edit the name.  The "Warn 
on Replace" checkbox allows you to specify whether or not you wish to receive a 
warning when you are about to replace a previously-stored formula.  The default 
is set to warn. 
 Process fields are included at the top of the dialog for the storage of 
formulas whose attributes differ from the default values as set in the Formulation 
tab of the Settings dialog. Identifying the Dye Class, Fiber Type, and Process for 
each formula gives users additional criteria when searching the database for 
specific standards/formulas. 
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Formulation Settings/Paints and Plastics 
 
 

Batch Settings 
 
 This tab of the Settings dialog allows you to select a formulation type as 
well as thickness values and resin quantities. The available fields are listed 
below. 
 

 
 
Type --- These radio buttons allow you to select the type of batch you are 
formulating with. 
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Select Thickness --- This allows you to set the thickness. 
 
Current Thickness --- This is the current setting for thickness. 
 
Total Batch Quantity, Resin Quantity, Can Prefill --- This field depends on the 
Type selected and allows you to enter the quantity for the batch. 
 
Can Used --- This drop-down list determines the can (units) used for the 
formulation.  
 
 

Formulate 
 

This tab allows the user to select from the settings governing the 
calculation of the colorant formula. 
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Component --- This field allows you to specify the number of colorants in 
combination you wish the system to use when formulating to the target. 
 
Resin --- These radio buttons allow you to select the resin types. 
 
Opacity Control --- This drop-down list allows you to set the opacity level you 
wish to be used. 
 
Colorant File Gloss --- This field allows you to enter a factor governing gloss in 
the colorant file. 
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Display 
 
 This tab governs the display of the formulas found by the system for the 
specified target. Field descriptions are included below. 
 
 

 
 
Recipe Display --- This drop-down list allows you to select from among the 
display options for formulas. The options are: Default Display, Alternate Form, 
Basic Materials Quantity Included, and Basic Materials Separated. 
 
Decimals Displayed --- This field allows you to set the number of decimal places 
to carry out the formulation amounts. 
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Display Cost With Recipe --- This checkbox causes the program to display cost 
information with the recipe if possible. 
 
Output Mode --- This drop-down list allows you to select the output mode for the 
formulation results. Its options are: Units, Weight, Volume, Shots. Selecting Units 
activates the fields below this list so that you may select Resin, Colorants, and 
Totals units individually. 
 
Match Result Filters --- These fields allow you to specify the maximum DE and 
SpD for formulation match results. 
 
Match Result Selections --- This section allows you to select values governing 
a database search for an acceptable formula. 
 
 
 

Formula Display 
 
 This tab allows you to select formula attributes for display. 
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Possible Columns --- This section of the dialog displays all of the possible 
attributes that you can select when displaying the formulas calculated by Color 
iControl. Options followed by a "/2" or "/3" indicate that those values can be 
displayed under the second and third illuminants, provided you check the 
"Display data for multiple illuminants" checkbox immediately beneath this 
selection box. 
 
Current Columns --- This box displays the current information selected for 
display about the formulas that the system calculates for the given target. 
Information is entered into this box from the Possible Columns section by 
selecting the desired item and clicking on the right-facing double arrow button. 
Items are removed by the reverse process using the left-facing double arrow 
button. The order of items may be altered using the up and down buttons at the 
right of this box. 
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Display data for multiple illuminants --- Checking this box will cause the 
program to display formulation data for all three selected illuminants. 
 
Predicted Performance Variation --- This field allows you to enter a percent 
value that represents the performance variation you expect in actual production. 
Color iControl then uses this value to predict the performance of the formulas it 
derives. 
 
 

Formula Printing 
 
 This tab allows the user to select formula attributes for inclusion in hard 
copy printouts of formulation results. 
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Possible Columns --- The items in this box are the available selections for 
hardcopy printouts of the formulas. Items followed by a "/2" or "/3" indicate data 
that will be displayed for the second and third illuminants. 
 
Current Columns --- The items in this box are those that are currently selected 
for display in printouts. To move an item from the possible to the current columns 
box, click on the desired item once to select it and then click on the right-facing 
double-arrow button between the boxes. Removing items from the current box is 
done by reversing the process and clicking on the left-facing double arrow button. 
The order of items in the current columns box can be altered by selecting the 
item and clicking on the <Up> and <Down> buttons to the right. 
 
Print Graphs --- Check this box if you wish to have the Predicted Performance 
graphs included when the Print command is selected from the Formulas Editor 
(Formula List) screen. 
 
Formulas Per Sort --- These three checkboxes allow you to set the number of 
formulas you wish to printout per each sort criteria selected for display in the first 
three columns. For example, you have Color iControl set to sort formulas 
according to Predicted Performance (Column 1), Metamerism (Column 2), and 
Cost (Column 3). Leaving these fields at their default setting of 5 means that you 
will recieve the five best formulas under each of these sort criteria. Since Color 
iControl may often find over a hundred formulas per target, this setting prevents 
you from wasting paper and time printing out all the formulas found, many of 
which would be unsatisfactory. 
 
Automatic Printing On --- Checking this box instructs the program to print the 
formulation results automatically as soon as the system finishes calculating for a 
specified target. 
 
 
 

Optimum Score 
 

 This tab allows you to select the criteria for the system to use when 
determining which of the formulas calculated is to be considered the "optimum 
formula". (The optimum formula is marked with the star icon, see image left.) You 
may select an attribute from each of the three drop-down lists. These three 
attributes will be used by the system when calculating each formula's "optimum 
score." In addition, you may use the slide bars on the right side to weight the 
attributes. You may select to "weight" each attribute in a range from half to one 
and a half times its normal setting. 
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Colorant File Tab 
 
 The Colorant File tab allows you to select a file containing colorant data 
for paints and plastics formulations. You may select  a colorant file from the 
available drop-down list or create a new colorant file. To create a new colorant 
file, type in the name for the new file in the field provided. Doing so will enable 
the <Create Colorant File> button. Clicking on the <Create Colorant File> button 
will open a second dialog box called "Set Up Colorant File." For more 
information, see Create Colorant File. 
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Create Colorant File 
 
To create a new colorant file, you will need to do the following: 
 
Set up the Colorant File by entering defaults such as name, instrument 
geometry, thickness and units and define the substrate. 
 
Define the Colorant File Samples, which involves: 

1. Defining the resin, white, and black information. 
2. Measuring resin, white, and black calibration samples. 
3. Defining the colorants and measuring calibration samples.  
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Follow the links for information about each step in this process. 
 
Setting Up the Colorant File ? Defining the Resin, White, and Black Calibration 
Samples ? Defining Basic Materials and Colorants
 
 
 

Setting Up the Colorant File 
 
 Once you have clicked on the <Create Colorant File> button, the "Set up 
Colorant File" dialog will appear (see image below). The name entered for the 
new colorant file will already be in place in the Name field. Follow the instructions 
below to fill in or select from the remaining fields. 
 

 
 

 1.   Click in the Additional Description field and type in any additional 
information about the colorant file. You may enter any information pertaining to 

100



the creation of the colorant file samples or method of reading the colorant file 
samples. 
 
 2.   Click on the Application drop-down list and choose the type of 
application that is being entered.  The choices are Paint or Plastics. 
 
 3.   Click on the Application mode drop-down list. Select the choice that 
best describes the way that the calibration samples will be read in.  The 
Application Mode will impact the colorant calibration samples processing.  
Choose one of the following Application modes: 

For Paint:  
Transparent: This mode should be used for applications 
that have no opacifying or scattering colorants.  The color 
calibration samples are all measured with a single 
reflectance measurement over a white substrate. There is no 
specified white or black colorant to use for calibration. 
Opaque:  This mode should be used for applications where 
the resin system is totally opaque and the colorant 
calibration samples are all measured with a single 
reflectance measurement.  Since the resin system is opaque 
there is no substrate to be measured.   
Over Light / Over Dark: This mode should be used for 
applications that use a "translucent-to-clear" resin system.  
The colorant calibration samples are all measured over light 
/ over dark on the user defined substrate.  

 
For Plastics: 

Opaque:  This mode should be used for applications where 
the resin system is totally opaque and the colorant 
calibration samples are all measured with a single 
reflectance measurement.  Since the resin system is opaque 
there is no substrate to be measured.   
Over Light / Over Dark: This mode should be used for 
applications that use a "translucent-to-clear" resin system.  
The colorant calibration samples are all measured in Over 
Light / Over Dark on the user defined substrate.  
Reflectance / Transmission: This mode should be used for 
Plastics applications that want to formulate from Translucent 
to Opaque and take advantage of the transmission 
measurement capabilities of the CE7000A. The samples are 
read in as reflectance and transmission measurements over 
a white tile defined as the substrate. 
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Transmission:  The mode should be used for applications 
that are totally transparent and need to be measured in the 
transmission mode. 

 
 4.   Click on the Specular Component drop-down list and select the 
measuring geometry used when measuring the colorant calibration samples. 
 
 5.   Click on the  Sample Amounts drop-down list and select either weight 
or volume for your sample input. This choice should reflect the amounts, whether 
they were weight or volume, that were used to create the calibration samples.  
 
 6.   Click on the Sample Thickness drop-down list and select either a 
thickness or weight per area measurement.  The "Calibrate with Thickness" 
check box should be checked only if you will be entering the thickness for each of 
your colorant calibration samples.   
 
 7.   Click on the selection field for Calibration Thickness: This value 
should represent the average thickness of the product you are producing.  This 
value will also be used as the default thickness amount for the formulation 
defaults. 
 
 8.   Click on Units button. The unit's window will appear that allows for the 
definition of the units that will be entered in the colorant file (see image below). 
The units displayed in this window should reflect the units that are being used to 
define the colorant file samples.  These values are only used as labels and the 
software is not converting or tracking the units for any conversion between 
different unit types. Choose a unit from the drop down list or type in the desired 
unit.  
 

 
 
 9.   Click OK/Save to save this data and return to the Colorant Setup 
display. 
 

102



 10.   Click the Substrate button. The Substrate dialog box appears (see 
image below).  Enter the Substrate Name and then follow the prompts to 
measure the substrate. 
 

 
 
 11.   Click the White button and the Measure Substrate display appears.  
Click the Measure button and a visual representation appears with the measured 
CIE Lab values. 
 
 12.   Click the Black button and follow the same procedure as described 
in the step above. 
 
 13.   Click OK/Save to save the substrate information and return to the 
Colorant File Setup screen. 
 
Important Notes: Once the Resin Calibration sample is entered and calibrated 

the ability to change a calibrating substrate, specular component, 
application, application mode, sample amount, or sample thickness is no 
longer available. For Reflectance / Transmission Colorant files you will see 
the energy factor value displayed in the Substrate display. 

 
For transparent applications, there will be no black substrate 
measurement.  
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For opaque applications, there will be no substrate measurement at 
all. 
When working with a Reflectance/Transmission colorant file the 
substrates are White and Black.  The White should be the 
reflectance measurement of the White tile backing your samples 
and the Black should be the Transmission measurement of the open 
port (with nothing in the transmission measurement holder).  For the 
transmission measurement the White tile should be placed in the 
reflectance sample position. 
For Transmission only colorant files the substrate should be an 
open port measurement (with no sample placed in the transmission 
sample area during measurement).  The spectrolon plaque should 
be placed in the reflectance sample position completing the sphere. 
(The same as for calibration.)  

 14.   Once you are finished entering the colorant file setup information, 
click OK/Save. The Resin Set Up display appears.  See Defining the Resin, 
White, and Black Calibration Samples for a view of the Resin Set Up display. 
 

 

Defining the Resin, White, and Black Calibration Samples 
 
 Once the set-ups are complete, you will need to add samples to the file.  
This process will entail the following: 
 

• Setting Up the Resin, White, and Black. 

• Measuring in the Resin, White, and Black calibration samples. 
 

Resin, White, and Black Set Up 
Once you have completed the colorant file setup, you may proceed 
with setting up the resin. 

1.   The Resin Setup window appears (see image below). 
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2.   Enter the Resin Name. If desired enter any additional 
information about the resin that you would like to note in the 
Additional Description field. 
3.   Enter the proper values for the following parameters.   

• Price 1: Enter the price in either cost per weight or 
volume depending on your formulation output.  
The cost will always be for the unit that you have 
entered.  For instance if you have entered the cost 
as $1.00/lb.  the cost of the formula will be for one 
pound of material. 

• Colorant Strength: You should initially leave the 
value at 100% because the initial colorants used 
for the calibration will be used for strength 
comparison.  If a colorant is found to be higher or 
lower in strength than the original colorant, 
increase or decrease this percentage to 
compensate for this strength difference.  For 
example, if the colorant is found to be 10% weaker 
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than the original colorant, decrease this value to 
90.  

• Specific Gravity: This value is used in a number 
of places in the software.  It is used in the 
calculation of the optical data (absorption and 
scattering) of a colorant, which is a volume related 
magnitude, but most program related entries are 
mass-related. Therefore it is necessary to have 
the specific gravity to convert from mass to volume 
for calibration. If all the colorants (including resin) 
have about the same specific gravity, the value 
can remain at one.  For Formulation display 
purposes this value is used to allow for the 
conversion of the displayed data between weight 
and volume or multiple pre-defined units. 

 
Note:   If the Units feature for Formulation will 
be used then the specific gravity must be entered for 
all of the resins, colorants, and wastes in that colorant 
file. 

• Alt. Weight: Describes the basic component 
make up for a concentrate or tint paste.  For 
example a 10% blue concentrate is made up of 
90% resin and 10% pigment.  The amount of blue 
pigment that is in a 150-gram batch of the blue 
concentrate would be 15 grams or 10% of the total 
amount.  The values entered should be 
percentages representing the amount of pigment 
that is in the concentrate or tint paste. These 
values are then used by the Alternate form display 
mode in the formulation view to show the amount 
of dry pigment that is used in the formula. 

• VOC:  Enter the amount of VOC that is present in 
the resin, colorant or waste. The VOC amount is 
expressed in a weight per volume unit.  For 
example it may be in Lbs./gal or Kg/L. 

• Concentration Percentage in Recipes: The 
entries relate to the minimum and maximum 
permissible concentration of the resin, colorant or 
waste used in a recipe.  Values entered in the 
colorant editor are used as the formulations 
defaults and can only be changed from the 
colorant editor.  
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4.   Enter the Basic Materials for the Resin, if there are non-
appearance effecting additives used in the resin system.  For 
more information, refer to Basic Materials. (Check with your 
application engineer before using this option.) 
5.   Once all the proper information is entered click Go To 
White. The White Set Up display will appear and you can 
enter all of the pertinent information for the white (see image 
below). 

 

 
 

6.   Once all of the white information is entered click Go To 
Black.  The Black Set Up display will appear (see image 
below) and enter all of the pertinent information for the 
Black.   
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7.   From the Measure Resin display (sample editor), 
highlight the 100% resin sample that automatically appears 
and click Next.   
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8.   Enter the proper amounts. Click Measure. You will be 
prompted to measure the sample for the type of colorant file 
you are building (Over White / Over Black, Single 
Measurement, Transmission, or Reflectance / 
Transmission.) 

 
9.   Once the resin sample has been measured click 
OK/Save. 

 
10.   From the Measure Resin display view click New. 

 
11.   Type in the name of the calibration sample to be 
measured and enter in the proper amounts defining that 
sample.  Click Measure to measure the sample. Once the 
sample has been measured click Next.  The Next button 
allows you to enter the next calibration sample. 

 
12.    Once all of the resin, white and black samples have 
been measured click OK/Save to store the calibration 
samples. 
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13.   From the Measure Resin window click Calibrate to 
calibrate the samples.  The Colorant Calibration display 
appears showing the back-predicted DE data for the 
calibration samples.  This data contains the Delta E values 
for the actual sample compared to the prediction made by 
the software for that sample. The maximum and average 
color distance DE data for the calibration set is displayed at 
the bottom of the window.  Click the Close button to go back 
to the Resin Set Up window. 

 

 
14.   Upon closing, the Resin Set Up window appears again.  
Click Close to return to the Define Colorant File window.  
Click Close to return to the formulation program or select a 
new colorant to continue. 

 
 
 

110



Defining Basic Materials and Colorants 

 Basic Materials 
The Basic Materials option allows you to apply a non-appearance-
influencing additive to a specific colorant or resin, in the predicted 
formula.  These can be applied in the Formulation view if you 
choose the Basic Materials Included or Excluded setting from the 
Matching display.  

Note:  Please consult with your applications engineer 
before using this option.  The additives may have an 
impact on how the colorant file samples should be 
produced. 

1. Click Basic Materials in the Set up Colorant window. 
The Basic Material Selection window appears.   

2. Click New to define a new additive, solvent, or binder 
to be used. 

3. Once a basic material is defined, it will appear in the 
Available Basic Materials list box.  All colorants, 
resins, and wastes that are listed in the colorant may 
use this basic material. 

4. To assign the available basic material for use with a 
specific colorant, highlight one of the basic material 
selections and click the [>] button or double click the 
selection.  After the selection is made, the Settings 
window appears.  Alter the % to the appropriate value 
and click OK/Save.  The selection has moved to the 
Selected Basic Materials column.  

5. If another selection is made, the remaining % will be 
reflected in the Settings window.   

6. Once all the proper information is entered click Close 
and the Set up Colorant or Resin display will appear. 

Defining the Colorants 
Once you have defined the resin, white colorant, and black 
colorants, you can define the remainder of the colorants. Proceed 
as follows. 

1. From the Define Colorant display click New Colorant. 
2. The Set-Up Colorant display appears.  

111



3. Type in the name of the Colorant along with the other 
details such as price, colorant strength, specific 
gravity, basic materials, etc. 

4. Click OK/Save.   
5. The Colorant Calibration Sample display appears.     
6. Click New.  The Sample Editor display appears.  
7. Type in the name for the first Calibration Sample for 

the selected Colorant.   
8. Type in the amounts of Colorant, Resin, White, and 

Black used to make the sample.   
9. Click Measure.  The software will prompt the proper 

measurement type for the type of application mode 
selected. 

10. Continue to enter any other calibration samples for 
the Colorant set by clicking Next.  

11. When the last colorant of the set is measured, click 
the OK/Save button.  The Colorant Calibration 
screen appears displaying all the Color distance DE 
data for this set. Click Close.     
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Correction/How To 
 
Correct a Formula 
 
The process of Correction allows you to enter a standard, select one of the 
formulas stored with that standard, and then retrieve or read in from the 
instrument a trial measurement representing the actual color being created by 
that formula in production. Color iControl will compare the two samples, the 
standard and the trial, and calculate the necessary additions or subtractions, 
from the stored formula, that will be required to alter the formula to produce 
samples that pass as on-shade. 
 
The image below shows the Correction Application screen. 
 

 
 
You will need to select the standard from the Standard drop-down list. You may 
also recall a standard from the database. 
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If the trial being used for the correction has been loaded into the job, you may 
select if from the Trial drop-down list. Otherwise, you will need to click on the 
<Measure Trial> button to the right of the field. 
 
The name of the substrate will be displayed. 
 
The “Correct From:” field allows you to select from the available formulas either 
stored with the standard, a trial, or a previously corrected formula stored in the 
job. 
 
The Current Colorant File will be displayed. You may select an alternate colorant 
file from the drop-down list. 
 
Clicking on the <Setup> button opens the Correction Inputs dialog box (see 
image below). 
 

 
 
This dialog box allow you to make selections regarding the correction. 
 
The “Flags” section allows you to Fix Resin Amount and Fix Resin percentage. 
This instructs the system not to alter the resin values but to only correct using the 
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colorants. You may also elect to display/use Performance factors (also known as 
correction factors, i.e. CF). 
 
The Colorant Selection section lets you allow new colorants, new wastes, a 
selected, or a colorant group. When using the Allow Selected option, you may 
select which colorants to correct by clicking on the Edit button and opening the 
Colorant Selection dialog box (see image below). 
 

 
 
Corrections are either “Additions to Batch” or “New Recipe” with available fields 
to specify amounts.  
 
Once you have made your selections, click on the <Correct> button. 
 
The corrected formula will appear in the Correction Output View at the lower left. 
See Correction Output Detail for information about the correction output. 
 
 
 
 

Correction Output Detail 
 
 Correction information is included in the lower left view in the Correction 
Application screen. The size of the columns may be changed by placing the 
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cursor on the columns separators. The cursor will change to a heavy black line 
with two arrows on either side. Click and drag to resize the column. 
 
When actually running a correction, you will have to use the scroll bar or print a 
hard copy to view all of the output. 
 
The data included in the correction output is listed and described below. 
 
Column One - Ingredient - This column contains the name of the colorant. 
 
Column Two - Entered Percent - This column contains the formula 
concentrations that were used to color the current trial. These values will usually 
come from the formulas stored with the standard. The units for this column are 
whatever current units have been chosen in general settings. The units can be 
changed, and all of the calculations will automatically be redone in the new 
current units. 
 
Column Three - Correction Factor [CF(Y/N)] - This column is the calculated 
correction factor between the entered concentrations (the values the user 
entered) and what Color iControl calculates to be the actual concentrations for 
the colorants in the formula. A (Y) or a (N) will appear beside the CF column title 
to indicate whether or not the correction factors are being used. If one or all of 
the correction factors exceed their limits (0.7 to 1.3), then an asterisk will appear 
beside those factors to indicate this.  
 
Column Four - New Percent - This column is the new calculated formula, in 
current units, taking into account the calculated correction factor (if used). This is 
the formula to use for a new dyeing. 
 
Column Five - Entered Amount – This is the amount of each colorant used in the 
original formula. 
 
Column Six – New Amount – This is the new amount for each colorant to be 
used in the corrected formula. 
 
Column Seven – Add Amount – This is the amount needed to add to make the 

batch conform to the correct formulation. 
 
Column Eight -- % Change – This column displays the change in the formula in 
percent. 
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eSubmit/How To 
 

eSubmit and Extended Tagging 
 
 The e-Submit option, along with Extended Tagging, allows users to enter 
information which is useful for customers working with their suppliers to 
electronically communicate color data throughout their supply chain; this is done 
through a set of fields (maximum 30) included as part of the information stored 
with the measurement. Usually this is done for the standard or target colors 
specified by the designer which needs to be reproduced in the color matching 
process. These "tagged" fields can be viewed in a special e-Submit View in the 
Quality Control mode (listed as just "Submit View" in the Change View dialog). 
Information included in the tagged fields may be printed out in the form of a 
report or transmitted electronically in the *.QTX or *.XML file format through your 
computer's e-mail system for use with ColorTools or NetPalette. Of course, since 
the data is embedded in the measurement itself, you may also e-mail a Color 
iControl job containing several data items which have been tagged provided the 
recipient also has Color iControl. In fact, the tagging function is useful even if you 
do not need to employ the e-Submit function.  
 
  Enabling the e-Submit Option 
 
 To enable the e-Submit option, you must check the "Enable e-Submit 
Option" under the Settings menu when there are no jobs open. The Settings 
menu is not available unless all jobs have been closed. 
 
For more information, see the How To topics below. 
 
Setup eSubmit ?  Edit an eSubmit Format File ?  Edit the eSubmit Fields ?  Send 
and receive eSubmit Files 
 

Setup eSubmit 
 
The e-Submit tool in Color iQC must be enabled before it can be used. To enable 
e-Submit, click once on the “Enable e-Submit and Extended Tagging” item under 
the Settings menu when there are no jobs open. This option will not be available 
through the Settings menu when a job is open. 
 
In addition to enabling the e-Submit tool, settings for the tool must be selected. 
The “Setup e-Submit and Tagging” option under the Settings menu will open a 
dialog box allowing you to do this (see figure below). 
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The first item is the e-Submit format file. You may select from the drop-down list, 
select to edit a file from the list, or enter a new name to create a new format file. 
Creating and editing a new eSubmit format file is covered in the How to Edit an 
eSubmit Format File. See that topic for more information. 
 
The rest of the fields will be settings employed system-wide and common to all 
jobs. 
 
The first checkbox allows you to set the system to only receive files formatted the 
same as the specified format file. Any other labels in the file will be ignored when 
the file is imported. 
 
The second checkbox informs the system to export all the eSubmit tags. 
 
The third checkbox informs the system to export the eSubmit fields only for the 
Standard data type. 
 
The two radio buttons in the center of the dialog are mutually exclusive. You 
must choose whether you are using the ColorTools format (QTX) or the 
NetPalette format (XML) for your eSubmit files. 
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The path fields following the radio buttons allow you to specify the folder (system 
directory) where you wish incoming eSubmit files to be stored prior to import. 
 
Three radio buttons allow you to select the Approval Function. The options are: 
General, Lab Dip, and Shade Band. 
 
Finally, a checkbox at the bottom allows you to set the system to automatically 
delete QTX and XML files located in the mailbox once they are imported into the 
system. 
 

Edit an eSubmit Format File 
 
You may edit or create a new eSubmit format file from the “Setup eSubmit and 
Extended Tagging” dialog box. 
 
To edit an existing file, select it from the drop-down list and click once on the 
<Edit this file> button below the list display field. 
 
To create a new format file, type in a new name in the list field, deleting the name 
displayed if necessary, and click on the <Edit this file> button. 
 
The Edit Format File dialog will open (see figure below). This dialog allows you to 
define the various data fields for use with the eSubmit and extended tagging 
functions. 
 
Enter the first item you want into the field at the upper right titled “Displayed 
Label”. The field below allows you to enter in an additional “Transfer Label” if it is 
needed. 
 
The drop-down list allows you to select the type of field the item will be: an 
editable text field, a drop-down list of predetermined options, or an editable list. 
 
The Values box below the list will become active if you select either the Drop-
down List or the Edit List option for the field. You may enter the values you wish 
displayed in the eSubmit field on separate lines by pressing the <Enter> key after 
each item. 
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Once you have the fields on the right side of the dialog filled in, click once on the 
<Add> button. The new item will be listed in the “Displayed Labels” box. 
 
The system will automatically increment the number of the field as items are 
added. You may change the order of the items by selecting one and using the 
<Up> and <Down> buttons to the left of the box. 
 
Click <OK> to finalize the modification or create the new file. 
 

Edit the eSubmit Fields 
 
To edit the eSubmit fields, you should make sure that you have the eSubmit View 
as one of your current views. If you do not, right-click in one of your views 
(preferably one you do not need) and select the Change View option. Select the 
Submit View (see figure below). 
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Now that you have the Submit view, you must select the data for display.You 
may use the “Show All” button in the Tree View toolbar. 
 
All items will be available in the view. How you edit each field depends on the 
type of field it is. 
 
The Text Edit type of field simply allows you to click within the field and place a 
text cursor into the field. Enter the desired text and then select the next field. 
 
The Drop List type of field will open the list when you double-click it. Each item 
will be displayed; scroll through the list and double-click your selection. 
 
The Edit List type of field opens that item’s Properties… dialog box where you 
may enter in your data directly into the submit fields for that item. 
 
The easiest way to perform this task is to fill out the Submit fields for the first 
sample and then use the “Copy information to all other measurements in view” 
button located beneath the sample selection drop-down list. All the other 
measurements selected for display in views will automatically be updated with 
the Submit field information entered into the currently displayed item. 
 
The other three buttons allow you to mark each item as not done (blue curved 
arrow), accept (green checkmark), or rejected (red X) once a determination has 
been made regarding that item’s disposition. 
 
The Visual comment field to the right top of the view allows simple text entry. In 
addition, another comment field is available in the Name tab of each item’s 
Properties… dialog. 
 

Send and Receive eSubmit Files 
 
 The e-Submit option allows you to submit targets (potential standards) to 
your customer electronically via e-mail. This prevents the time consuming 
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process of sending colored swatches to your customer via ordinary mail and then 
waiting for a response. Data on your targets is stored in a QTX (ColorTools 
format) or XML (NetPalette format) file and the recipient must have a software 
package capable of reading that file format (or Color iQC). Instructions for using 
the e-Submit option are listed below. (For more information on the e-Submit 
option, see the Tools menu options as well as eSubmit and Extended Tagging.  
 
Sending an e-Submit file 
 
  1.  Be sure that the program is in Quality Control mode and that the 
Submit view fields for each target have been properly filled out. 
 
  2.  Select the targets (trials) from the Tree View by clicking on them 
once to highlight. You may use <Ctrl>+click to select individual items or select an 
item and then use the <Shift>+click combination to select a range. 
 
  3.  Once the needed items are selected, click on the "e-Submit xx 
items" command either in the Tree View's right-click menu or from under the 
Tools menu.  
 
  4.  A dialog box will appear prompting you to name the file. The 
default behavior is to name the file according to the current standard in the job. 
However, you may alter that to any file name that you wish. 
 
  5.  Once you have name the file, the system will automatically open 
your e-mail utility, create a new e-mail, and attach the file you just created. The 
name of the current standard from the job used to create the file will be inserted 
into the subject line of the e-mail. 
 
  6.  Address the e-mail as usual and click <Send>. 
 
  7.  Your customer will receive the submitted targets for evaluation. 
 
Receiving an e-Submit file 
 
 If you are on the receiving end of an e-Submit file, you may open that file 
by using the "Read an e-Submit file" command under the Tools menu. The data 
in the file will be imported into the current job, so it is a good idea to open a new 
blank job before using this command. Otherwise, the imported data will be mixed 
in with whatever data was in the job that was open when you executed the 
command. In addition, the standard in the file will replace the standard in the 
current job (if there is one). 
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Taper Tool/How To 

Setup the Taper 
 
Click on the “Setup SLI-Taper parameters” option from the Tools menu. The SLI-
Taper Tolerances and Commands dialog will open (see figure below ). From this 
dialog, you must select the way in which you wish the taper calculations to be 
performed by the system. 
 
 

 
 
 
There are four tolerances: Standard, Average, Range, and Roll. The Standard 
tolerance is the maximum acceptable dEcmc between a sample and the 
standard. The Average tolerance is the maximum acceptable dEcmc between a 
sample and the average of all the samples. The Range tolerance is the maximum 
acceptable dEcmc between the last and first samples in a linear taper group. The 
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Roll (to-Roll) tolerance is the maximum acceptable dEcmc between two adjacent 
samples. 
 
For an explanation of the Sequencing and Grouping settings options, see the 
Methods of Tapering and Grouping topic.  
 
The Grouping Limits section allows you to enter the upper and lower limits for the 
LMD or Bsort grouping methods. These values are in DEcmc units. 
 
Three checkboxes allow you to select to print separate reports for each tapered 
group, to automatically print the report once the taper is done, and automatically 
exit SLI-Taper and return to Color iQC once the calculations have been 
completed. 
 
The last section is for users who are using the remote server option. It has three 
fields. The first is the network name for the computer where the remote server is 
installed. The second identifies the path to the folder where the taper.dat files are 
stored prior to loading them into the program. The third identifies the computer by 
network name where the Adaptive Cluster Server has been installed. 
 

Calculate the Taper 
 
 
(These instructions assume that the taper calculation parameters have been 
selected in the SLI-Taper Tolerances and Commands dialog. See How to Setup 
the Taper for more information.) 
 
To calculate the taper, the first step is to select all of the data in the tree view for 
display. Remember, the data type icon for selected data is colored; for 
deselected data, it is greyed out. This will ensure that all of the measurements 
are properly imported into the SLI-Taper software. 
 
Once the data is selected, you should make sure that the Grp/Sequence attribute 
has been selected for display in the Standard/Multi-Trial view. This will ensure 
that the data will be displayed in its tapered order once SLI-Taper has completed 
its calculations. 
 
Open the Tools menu and click on the SLI-Taper command. Once SLI-Taper has 
run, you may examine the taper report within the SLI-Taper program or exit and 
examine the data in Color iQC, that is, unless the “Automatically exit SLI-Taper” 
checkbox has been selected in the setup dialog. 
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Methods of Tapering and Grouping 
 
Linear Tapering 
 
 Linear tapering is the simplest way to taper a group of samples. This is a 
method used when the major variation in color exists in only one direction in color 
space, or when the variation of one color parameter is predicted by a second, 
that is, the samples only run from lighter to darker, or from duller to brighter. 
When this is the case, a straight line-of-best-fit is calculated through the 
distribution of the sample readings and followed from one end to the other, 
consecutively ordering samples as they are encountered. Generally, a preset 
tolerance is programmed into the calculations so that if the distance between two 
adjacent samples is over a certain value (typically 0.40 dEcmc units), a new 
taper sequence is begun. In this way, more than one taper group may be 
calculated from a single set of data. A linear taper is generally most effective 
when variations in the data are predominantly in lightness and/or chroma. 
 
Minimum Path Tapering 
 
 Minimum path tapering is used when the distribution in the data set is 
more random. The goal of a minimum path taper is to plot a line through the 
samples such that the total colorimetric distance (measured as dEcmc) required 
to travel that line is the lowest possible value while still including all the samples 
in the distribution. In other words, we are seeking the minimum path through the 
data set. Research performed by SheLyn, Incorporated has demonstrated that 
this will generally produce a taper sequence very similar to those produced by 
human shade sorters. However, this method only works when the distribution of 
the data is uniformly random. If the distribution is linear in any way, a minimum 
path calculation will produce a taper that is less satisfactory than those produced 
by the linear method above. 
 
 
Grouping Methods 
 
Clustering 
 
 The distribution of the data can also affect the taper in another way. The 
above methods only work well when the data is distributed in a more or less 
uniform fashion. After the data is plotted, if distinct subgroups, or clusters, of 
points exist, then tapering the group by either the linear or minimum path method 
may prove unsatisfactory. While gaps in the plotted data created by the uneven 
grouping can be taken into account so that each break is treated as a new taper 
sequence, a better method is to divide the entire data set into clusters prior to 
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applying the taper process. This method of clustering non-uniform data sets 
before tapering, either by linear or minimum path method, is generally thought to 
be more effective than simply allowing the computer to treat breaks as new taper 
sequences. 
 
Linear Grouping 
 
 SLI-Taper/W™ has two other ways to group the data set so that more 
than one taper can be performed. The first is linear grouping. Two options exist 
for this method. The data set can be divided into two or three linear groups. This 
method of dividing the data set relies on the same calculation as a linear taper, 
that is, determining the line-of-best-fit. Dividing the data into two groups is quite 
simple. The line-of-best-fit is calculated through the data set and then all the 
points that fall above that line are one group and all the points that fall below that 
line are the second. These two groups may then be tapered by either the linear 
or minimum path method. (Linear grouping is just that, grouping. It does not imply 
that the linear method of tapering must be used.) Dividing the data set into three 
groups is a bit more complicated. Again, the line-of-best-fit must be calculated. 
However, for three groups, two more lines are placed into the data set, one 
above and one below, parallel to the line-of-best-fit. The three groups are then 
formed by the samples above the top line, the samples below the bottom line, 
and the samples between the two parallel lines. As with two linear groups, these 
three groups may be tapered by either the linear or the minimum path method. 
 
LMD Grouping 
 
 The second method of dividing up a data set for tapering is through LMD 
grouping. As with the linear grouping, SLI-Taper/W™ can group data into two or 
three LMD groups depending on what the user chooses. This method uses the 
lightness value of the data to divide it up into light, medium, and dark samples 
(hence the term LMD grouping). Limits in dEcmc units which define how these 
groups are formed are either specified by the user or the program may be set to 
calculate these from the data. That is, how many dEcmc units must the program 
move upwards from the lightest sample before it should consider the samples it 
is encountering to be of medium lightness, and then dark. Obviously, when 
dividing the data into only two groups, the medium lightness value is omitted. 
 
 
BSort Grouping  
 
 The third method is called B sort grouping. This method of dividing up 
the data set uses the b* value for each sample, comparing it to the standard. This 
method is especially useful for denim. It divides the data set up according to 
whether or not it tends towards the yellow end of the b* axis or the blue end of 
the b* axis. You may select to group the data into two or three BSort groups, or 
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you may let the program auto-select a BSort method. Samples which exceed the 
standard tolerance or which exceed the dEcmc average for the data set will be 
sorted into separate groups but not tapered. 
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Menu Commands 

 

File/Job 
 
 Note: This topic actually covers two different menus, File and Job. The 
File menu is only available when there are no jobs open in the main program 
window. The Job menu is only available when there are jobs open in the main 
program window. Basic commands are present in both menus but some 
commands are unique and only available in the menu in which they appear. 
 
 The definition of a job in Color iControl depends on how you wish to set up 
the system for the completion of your work.  The exact nature of a job has been 
kept open-ended to provide flexibility in the program for the complete spectrum of 
customers who may be using the software.  Jobs may be defined to keep 
separate the different tasks that Color iControl allows to be performed.  One job 
may be set up to contain all the data for a complete QC operation, including the 
standard and all the samples, as well as spectral data on the substrates, 
whereas another job is set up to contain a target or targets, a set of colorants, 
and data on the desired substrates in order to carry out formulation. 
 
 On the other hand, jobs may be set up to be operator-specific.  That is, 
instead of defining jobs based on their operational mode, jobs may be defined 
according to who will be running that job.  Alternatively, jobs could be set up to 
reflect their respective points of origin, keeping dye house jobs separate from 
jobs being run in the laboratory. 
 
 In essence, jobs are files, except that a job will store and keep separate 
the various types of data stored within it (i.e., trial samples, primaries, substrates, 
colorants).  The Job menu takes the place of the File menu that is seen in many 
Windows applications, and it contains many of the same types of commands that 
a file menu would have.  Click on the jumps below for more detailed information 
about either job conventions in Color iControl or specific instructions about the 
Job menu options. 
 
File Menu Options ?  Job Menu Options
 

File Menu Options 
 
 The File menu is only available when there are no jobs open in the main 
program window. Available commands are listed below with a brief explanation. 
Links are provided to topics with more information. 
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New Job-- This command opens a new job in the current mode using the Color 
iControl default template.  The keyboard alternative is Ctrl + N. 
 
New From Template -- This command opens a new job from a user-selected 
template.  The keyboard alternative is Ctrl + T.  A template may be created from 
any currently selected job.  For more information, see Settings Files, Templates, 
and Layouts. 
 
Open -- Open allows you to open a pre-existing job that has been stored on the 
computer's hard drive.  The keyboard alternative is Ctrl + O. 
 
Open Active Correction -- This option allows you to open a currently active 
correction job.  Note: Unavailable in the QC version of Color iControl. 
 
Open Check Tile Job -- This command opens the check tile job where check tile 

readings from instrument calibrations are stored so that the user may review 
them.  

 
Edit Default Job Settings --  It allows you to edit the default settings file 
associated with the default template.  Follow the jump for more information. 
 
Edit a Template -- This command allows you to open and edit a template.  
 
Edit a Job Settings File --  It allows you to open and edit any settings file that has 
been stored. 
 
Batch Job Conversions -- This command allows you to convert a group of files by 
changing the associated settings file for all of the selected jobs. Click on the jump 
for more information. 
 
Print -- This command opens a dialog box which allows you to print the current 
job and to choose such options as the printer, page orientation, number of pages 
to print, etc. There is also a Properties button allowing further options for printing, 
such as Paper (select tray), Graphics, Device Options, and PostScript. When 
using this print option, only those views that have had the "Include in Full Print" 
option selected in their right-click menu will be included. 
 
Print Setup -- This command opens a dialog which allows you to specify printing 
options for hardcopies of data stored or calculated by Color iControl.  
 
Print Preview  --- This option opens a screen-sized dialog box which will display 
the current job as it will be printed out. You may move from page to page and 
examine the formatting for the print job, as well as display two pages side-by-
side. 
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Single View Print Setup --  This option opens the same dialog box as the main 
Print Setup option. The only difference is that selections made using this 
command control the printing of a single view. Color iControl allows you to print 
individual views, such as the Standard/Multi-Trial View or the Color Space View. 
The individual print option for views is selected by using the Print command in 
that view's right-click menu. 
 
 

Job Menu Options 
 
 The Job menu is only available when there is at least one job open.  The 
options available through the Job menu are described below. 
 
New Job-- This command opens a new job in the current mode using the Color 
iControl default template.  The keyboard alternative is Ctrl + N. 
 
New Job from Template -- This command opens a new job from a user-selected 
template.  The keyboard alternative is Ctrl + T.  A template may be created from 
any currently selected job.   
 
Open Existing Job -- Open allows you to open a pre-existing job that has been 
stored.  (See also Recent Files, below.)  The keyboard alternative is Ctrl + O. 
 
Open Active Correction -- This option allows you to open a currently active 
correction job.  This option is only available in the iMatch version of Color 
iControl. 
 
Close Current Job -- This option closes the current job. You will be prompted to 
save the job if you have not already done so. 
 
Quit Current Job without saving -- This option quits the current job so that the 
system will not prompt you to save it. 
 
Save -- This command will save the current job.  The keyboard alternative is Ctrl 
+ S. 
 
Save As -- This option allows you to save the current job under a new name. 
 
Save As Template -- This option allows you to create a template from the current 
job.  
 
Save Settings -- This option saves the current job settings to the settings file with 
which that job is associated.  
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Recall Settings -- This option recalls into the current job the original settings from 
the settings file associated with that job. This option allows you to make changes 
to the settings in a job (without saving them) and then recall the original settings 
by clicking once on this command. 
 
Change settings file reference -- This command allows you to change the 
settings file associated with the currently active job. In addition, this command 
allows you to create new settings files.  
 
 Print -- This command opens a dialog box which allows you to print the current 
job and to choose such options as the printer, page orientation, number of pages 
to print, etc. There is also a Properties button allowing further options for printing, 
such as Paper (select tray), Graphics, Device Options, and PostScript. When 
using this print option, only those views that have had the "Include in Full Print" 
option selected in their right-click menu will be included. 
 
Print Setup -- This command opens a dialog which allows you to specify printing 
options for hardcopies of data stored or calculated by Color iControl.  
 
Print Preview -- This option opens a screen-sized dialog box which will display 
the current job as it will be printed out. You may move from page to page and 
examine the formatting for the print job, as well as display two pages side-by-
side. 
 
Single View Print Setup --  This option opens the same dialog box as the main 
Print option. The only difference is that selections made using this command 
control the printing of a single view. Color iControl allows you to print individual 
views, such as the Standard/Multi-Trial View or the Color Space View. The 
individual print option for views is selected by using the Print command in that 
view's right-click menu. 
 
Recent Jobs -- Recently opened or created jobs will appear here for easy recall.  
Choose a job from the list to recall it in its last-used mode. 
 
Mail -- This option allows you to e-mail jobs to another location.  Follow the jump 
for more information. 
 
Delete Current Job -- This command deletes the current job. 
 
Exit -- This command allows you to exit Color iControl. 
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Settings Menu 
 
 The Settings menu only appears when there are no jobs open. Each item 
is listed below with a brief explanation. 
 
Toolbars --- This menu item allows you to select to view and access the toolbars 

in Color iControl. 
 
Status Bar --- This menu item allows you to select to view or not to view the 

status bar at the bottom of the Color iControl window. 
 
Add Trials to top of list --- When selected, this item instructs the software to add 

newly measured trials to the top of the trial list in the Tree view. Checked 
equals selected; unchecked equals unselected. 

 
Edit Default System Settings -- This command opens the System tab of the 

Settings dialog box which allows you to specify the working paths for 
storing jobs, settings etc. 

 
Setup eSubmit and Tagging --- This command opens a dialog box which allows 

you to select among the various options for using the eSubmit and 
Extended Tagging functions. See eSubmit and Extended Tagging for 
more information. 

 
Enable eSubmit and extended Tagging --- Clicking on this item enables the 

eSubmit and Extended Tagging functions. Checked equals selected; 
unchecked equals unselected. See eSubmit and Extended Tagging for 
more information. 

 

Application 
 
 The Application menu is mostly unavailable in the Quality Control version 
of Color iControl (Color iQC). The other applications will be listed but grayed out 
unless you purchase the iMatch version of Color iControl. The one option that will 
be available Settings      dialog. The Settings dialog is also available through the 
"Pad and Pencil" button on the toolbar. 
 

View 
 
 This menu allows you to set up the screen display according to your 
personal preferences. This menu will have different options depending on 
whether or not there are any jobs open. The items which only appear when no 
jobs are open are notated below. 
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Status Bar -- When selected, this option displays the status bar at the bottom of 
the screen.  Deselecting this option causes the status bar not to be displayed. 
 
Toggle button text -- This option will toggle between displaying text labels for 
each of the toolbar buttons and only displaying the icon. 
 
Add trials to top of list -- When selected, this item adds any trials read in from the 
instrument to the top of the tree view's trial list. This allows you to see each 
sample as it is read without continually scrolling the tree view to the bottom. 
 
Sort Measurements by... -- This option allows you to sort the measurements 
displayed in views by their full name or any part of a formatted name. 
 
Single Trial QC Display --- This option converts the Standard/Multi-Trial view into 
a simplified standard/trial view which allows only one trial to be compared to the 
standard at a time. 
 
Toggle Full QC Tree View --- This option toggles the Tree View to take up the 
maximum space vertically within the job window. 
 
Clear all Highlights -- This option will clear any highlights in the views. 
 
 
 
Accessing View Options Using the Mouse 
 
 The mouse may be used to resize or change the current views. 
 

Resizing the View : Click on the view you wish to alter.  It will 
become outlined in amber.  Place the cursor on the amber line.  It 
will change shape to a double-line with two arrows pointing in 
opposite directions.  Holding down the left mouse button, drag the 
cursor until the view is the desired size.  Let go of the mouse 
button. 
 
Changing the View : To change a view, right-click once in the view 
to select it. The currently active view will be highlighted in amber.  A 
menu box will pop-up with various options.  Select "Change View".  
The Change View dialog box with the available view options will 
appear.  Click on the desired view and select OK.  The new 
selection will appear in the view box. 
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Spectro 
 
 The Spectro menu allows you to perform operations dealing with the 
program's interaction with the spectrophotometer. Each of this menu's available 
options are listed below with a brief explanation. In some cases, jumps will be 
provided to topics with more detailed information on that subject. If no jobs are 
currently open, then the only option available will be "Install or Configure." See 
Spectro Management for more information. 
 
Available Spectro Menu Options 
 
Reset Spectro Connection - This menu item is really only applicable for those 
users who have more than one spectrophotometer available for use with the 
program. This command is included for those rare occasions when you need to 
change spectrophotometers for an open job. Normally, a job is associated with 
the instrument selected when that job is first opened. To do this, click on the 
"Install or Configure" option. The Install Spectro dialog box will appear. Select the 
instrument you desire to associate with the current job. Click <CLOSE>. Then, 
click on Spectro | Reset Spectro connection. The previously selected 
instrument should now be the instrument associated with that job. 
 
Select Mode --- This command allows you to specify certain operating 
parameters for the spectrophotometer. Follow the jump to receive complete 
instructions on selecting instrument modes. 
 
Calibrate --- This command allows you to standardize the instrument. Follow the 
jump for instructions on standardizing your instrument. 
 
Install or Configure --- This command allows you to install or configure any 
instruments connected to the computer running Color iControl.  
 
See the topics under Spectro Management for more information. 
 

Account 
 
 This menu item has three or four options, Change, Manage, Save Registry 
Settings, and Restore Registry Settings, depending on whether or not you have a 
job open. 
 
 The "Change" option brings up the original splash screen where you 
logged on prior to using the program.  This option may be used to change the 
current user to another user without shutting down the program. 
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The second option, "Manage", brings up a dialog box (below) which allows 
the system manager to set up user accounts, including passwords and menu 
access based on those passwords.  
 

 
 
 The last two options, Save Registry Settings and Restore Registry 
Settings, are useful in a variety of situations. They allow you to save a copy of 
the registry settings as currently set for the software in a file which is placed in 
the main Color iControl folder on the C: drive. This file will be named 
"ColoriControl.rgs." Since many of the program's default behaviors are saved in 
the Windows registry, this file can then be used to "Restore Registry Settings". 
This is most often done when a computer has crashed and the main hard drive 
has had to be reformatted or when upgrading to a better machine and the 
software (along with the operating system) has to be installed from scratch. This 
command allows you to import your old settings without having to recreate them 
using the program. 
 

Window 
 
 The Window menu allows you to control the display of the job windows 
while Color iControl is running.  There are only four commands, Cascade, Tile 
Vertical, Tile Horizontal, and Close All Jobs.  The Cascade command can only be 
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used when you have more than one job open.  Cascade will pile the different jobs 
you have open one on top of the other with the current job on top.  All that will be 
visible of the other open jobs is the title bar.  Clicking on any of the visible title 
bars will select that job as the current job and place it on top of the stack. 
 
 Tile Vertical and Tile Horizontal open the jobs side-by-side either vertically 
or horizontally. Generally, the number of jobs you can tile (either way) is 
dependent on the size and resolution of your monitor. 
 
 The Close All Jobs command automatically closes all jobs and saves any 
changes. If you have any open jobs without names, you will be prompted to 
name the job before it is closed by Color iControl. 
 
 In addition to above commands, there will be a list of currently open jobs 
at the bottom of the menu which allows you to select a job with the mouse to 
bring to the front. 
 

Tools 
 
 The Tools menu allows access to a variety of procedures designed to 
supplement the operation of the Color iControl package. Currently, the main 
supplemental option available is SLI-Taper, SheLyn's shade tapering software. 
The Tools menu allows you to run SLI-Taper (both the 16 and 32-bit versions) 
without exiting from Color iControl. This option must be run from the QC Mode. In 
addition to the SLI-Taper option, the Tools menu also includes the e-Submit 
function. Commands associated with each of these functions are listed below 
with a brief explanation. 
 
 
SLI-Taper --- When you select this command, the data currently selected in the 
Job Tree for display in the QC views will automatically be imported into the Taper 
program and tapered according to SLI-Taper's current settings and then exported 
back into Color iControl and displayed. A hotkey option has been included to 
allow quick access to the Taper function: <Shift> + <Alt> + T. (You should make 
sure that you have the Group/Sequence item selected for display in the 
Standard/Multi-Trial view. This can be done from the Standard/Multi-Trial View 
Properties dialog available through the right-click menu.)  
 
Import SLI-Taper sequence --- This command will import the last taper performed 
by SLI-Taper. This data is kept in a file that is overwritten every time you run a 
taper, so only the last taper performed is available. 
 
Enable Adaptive Cluster Label after Read --- This option is a toggle control which 
allows the system to be set to automatically adaptively cluster a sample 
immediately after it has been measured with the spectro. 
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Setup SLI-Taper parameters --- This command opens a dialog box allowing you 
to select various parameters governing how the taper is to be performed, 
including the taper method, grouping method, and various tolerances governing 
the taper (see image below). You may also specify the name of a Taper Settings 
File containing that information. For more information about these settings, you 
should see the documentation provided with your SLI-Taper option. 
 
Send an e-Submit using selected trials --- This command will take the selected 
trials and place them into a QTX or XML file. (You should first enter in any of the 
"submit" information needed for each trial using the e-Submit view. You will be 
prompted to name the file. After you name the file, the system will automatically 
open a new e-mail dialog box and append the QTX file to the blank e-mail. You 
will need to enter the addressee for the e-mail and enter a message, then click 
the <Send> button. The e-mail will be sent to its destination with the QTX file 
attached.  
 
Read an e-Submit file --- This command allows you to select a  file (QTX, XML, 
etc.) that has been sent to you  via e-mail and import the contents into a job. 
Clicking on this file will cause the Open dialog box to appear with the contents of 
the Jobs directory displayed (or whatever you have set as your default jobs 
folder). Select the file by clicking on it and then click <OK>. (You may have to 
save the file from the e-mail it was sent with to this directory. See note below.) 
The data in the file will be imported into the currently open job. The standard 
located in the file will replace the standard in the job; therefore, you may want to 
open a new job for importing the data. 
 
Important Note: Receiving an e-Submit file 
 
 When receiving the file generated by the e-Submit option, you will need to 
save the file (attachment) from the e-mail in which you receive it into the "Color 
iControl\Jobs" directory (folder). Exactly how you do this depends on the e-mail 
software you are using. Some e-mail systems display the attached file as a small 
icon. When this is the case, you may simply right-click on the icon and select the 
"Save As..." option. Other e-mail systems may have a small button you have to 
click on to see the attached file and access the save options. See the 
documentation for your e-mail software for more information. 
 
Setup Tagging Format --- This command opens the “eSubmit and Tag Settings 
dialog which allows you to select the format file for the eSubmit and tagging 
functionality. See the topics under eSubmit/How To for more information. 
 

Macro 
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 The macro menu has two main commands: Edit/Create a Macro and 
Open Macro. 

Help 
 
 The Help menu contains two options when you have a job open, Help 
Topics and About Color iControl.  The first will open this indexed help file and 
allow you to browse for topics containing information about the running of Color 
iControl. 
 The second command will bring up the Color iControl "About" box which 
provides certain basic information about the software (see image below). The 
version number and copyright information is listed there, as well as a field 
displaying the expiration date of your software service agreement and a button 
allowing you to check for software updates.  The "About" box also displays 
whether or not you have SLI-Taper as an option, as well as the serial number of 
your software activation license. 
 

 
 
 If you do not have any jobs open, the Help menu has an additional item, 
License Activation, which opens the  dialog box used to contact GretagMacbeth 
via the internet and download the activation code needed to license the software 
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for use. In addition, the License Activation dialog also has buttons allowing you to 
transfer the existing license to another computer. This allows users to periodically 
update their hardware without having to contact GretagMacbeth for a new user 
license. 
 

139


	Color iMatch Paint Help
	PDF files of the Online Help System for Color iMatch Paint

	Getting_Started.pdf
	Getting Started
	Edit Default System Settings
	General Settings
	QC Settings
	Settings Options
	Advanced QC Settings
	How to Set Pass/Fail Tolerances
	Shade Sorting in Color iControl


	Desktop_Management.pdf
	Desktop Management
	Desktop Management
	Permissions Descriptions
	Toolbar Buttons
	Tree View Toolbar Buttons
	Settings Files and Templates


	Data_Management.pdf
	Data Management
	Recalling Data from the Database
	Selecting the Data from the Possible Matches
	Save to Database
	Create an Empty Data Base
	Upgrade the Database
	Delete Data from the Database
	Naming Conventions
	Import...
	User Groups
	Data Properties
	Basic Data Properties
	Data Condition
	Spectral Data
	Additional Properties of Standards
	Tolerances Used
	Recipe/Formula Editor


	Spectro_Management.pdf
	Spectro Management
	Install or Configure
	Installing a New Instrument
	Modifying an Existing Instrument
	Deleting an Instrument
	Changing the Mode of an Instrument
	Changing the Comm Port of an Instrument
	Select Mode
	Calibrate
	Calibrating with a Colored Check Tile
	Setting Up the Colored Check Tile Option
	Disabling the Colored Check Tile Calibration Option
	Using the Colored Check Tile During Calibration
	UV Calibration Dialog
	Measuring Data from the Instrument
	Setting up the Measurement Process
	Measuring Data: The Process
	Additional Elements of the Measure Dialog
	Timed Measurements
	Upload Data from a Portable Spectrophotometer


	Color_Difference.pdf
	Color Difference/How To
	Display Data in Views
	View Color Difference Data
	Change Views/Edit a View’s Properties
	Print Color Difference Data
	Attributes for Standard/Multi-Trial View Display


	Formulation_paint.pdf
	Formulation/How To
	Preliminaries to Formulation
	Viewing Data in the Formulation Application
	Formulating for a Single Target
	Formulating for Multiple Targets
	Viewing and Evaluating Formulation Results
	Examining Formulation Results Graphically
	Storing a Formula


	Colorant_file.pdf
	Formulation Settings/Paints and Plastics
	Batch Settings
	Formulate
	Display
	Formula Display
	Formula Printing
	Optimum Score
	Colorant File Tab
	Create Colorant File
	Setting Up the Colorant File
	Defining the Resin, White, and Black Calibration Samples
	Defining Basic Materials and Colorants


	Correction_paint.pdf
	Correction/How To
	Correct a Formula
	Correction Output Detail


	eSubmit.pdf
	eSubmit/How To
	eSubmit and Extended Tagging
	Setup eSubmit
	Edit an eSubmit Format File
	Edit the eSubmit Fields
	Send and Receive eSubmit Files


	taper.pdf
	Taper Tool/How To
	Setup the Taper
	Calculate the Taper
	Methods of Tapering and Grouping


	Menu_Commands.pdf
	Menu Commands
	File/Job
	File Menu Options
	Job Menu Options
	Settings Menu
	Application
	View
	Spectro
	Account
	Window
	Tools
	Macro
	Help


	website imatchindustrial cover.pdf
	Color iMatch Industrial Help
	PDF files of the Online Help System for �Color iMatch Indust





